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KATA PENGANTAR

Modul dengan judul “Mengoperasikan Software 2D Animation

merupakan bahan ajar yang digunakan sebagai panduan praktikum

peserta diklat Sekolah Menengah Kejuruan (SMK) untuk membentuk salah

satu bagian dari kompetensi bidang keahlian Teknologi Informasi &

Komunikasi pada Program Keahlian Multimedia.

Modul ini menguraikan tentang cara mengoperasikan software 2D

animation SWISHmax. Kegiatan Belajar 1 membahas tentang mengenali

menu, membuat, membuka, menyimpan file animasi 2D.  Kegiatan Belajar

2 mengenali menu, membuat, membuka, menyimpan file animasi 2D.

Kegiatan belajar 3 merupakan bahasan tentang membuat animasi 2D

sederhana. Untuk Kegiatan Belajar 4 merupakan mengintegrasikan

animasi 2D ke dalam multimedia.

Modul ini terkait dengan modul-modul lain yang membahas tentang

mengoperasikan software pengolah gambar vector(digital illustration),

mengoperasikan software pengolah gambar raster (digital imaging), dan

melakukan entry data (grafis) dengan menggunakan Image Scanner .

Oleh karena itu, sebelum menggunakan modul ini peserta diklat

diwajibkan telah mengambil modul-modul tersebut.

Yogyakarta, Desember 2004

Penyusun

Tim Fakultas Teknik

Universitas Negeri Yogyakarta
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Keterangan:

A HDW.OPR.105.(1).A Mengoperasikan periferal untuk pembuatan
grafis

B DTA.OPR.102.(1).A Melakukan entry data [grafis] dengan
menggunakan Image scanner (Level 1)

C SWR.OPR.408.(1).A Mengoperasikan software pengolah gambar
vektor (digital illustration)

D SWR.OPR.409.(1).A Mengoperasikan software pengolah gambar
raster (digital imaging)

E HDW.OPR.106.(1).A Mengoperasikan periferal web
F DTA.OPR.102.(2).A Melakukan entry data [web] dengan

menggunakan Image scanner (Level 2)
G SWR.OPR.414.(1).A Mengoperasikan software web design
H SWR.OPR.415.(1).A Mengoperasikan software 2D animation
I SWR.OPR.413.(1).A Mengoperasikan software FTP
J HDW.OPR.107.(1).A Mengoperasikan periferal multimedia
K DTA.OPR.102.(2).B Melakukan entry data [multimedia] dengan

menggunakan Image scanner (Level 2)
L SWR.OPR.416.(1).A Mengoperasikan software multimedia
M SWR.OPR.407.(2).A Mengoperasikan software presentasi (Level 2)
N HDW.OPR.108.(1).A Mengoperasikan periferal animasi 3D
O SWR.OPR.417.(1).A Mengoperasikan software basic 3D animation

(Level 1)
P SWR.OPR.418.(2).A Mengoperasikan software model 3D animation

(Level 2)
Q HDW.OPR.109.(1).A Mengoperasikan periferal perekam suara
R HDW.OPR.110.(1).A Mengoperasikan periferal perekam gambar
S SWR.OPR.419.(1).A Mengoperasikan software digital audio
T SWR.OPR.420.(1).A Mengoperasikan software digital video
U SWR.OPR.421.(1).A Mengoperasikan software visual effects
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PERISTILAHAN/GLOSSARY

Animation

Animasi dari beberapa gambar diam dibuat seperti hidup tanpa ada patah-

patah dalam pergerakannya.

Banner

Merupakan kepala atau bagian atas dari sebuah web site.

Download

Proses pengambilan file atau mengcopy file.

Effect

Tindakan yang dikerjakan untuk menghaluskan atau memperindah

animasi pada obyek.

Event

Tindakan yang dilakukan setelah adanya action.

Export

Merubah jenis format ke bentuk yang lain.

Format

Bentuk ektensi dari jenis file.

Frame

Bagian dari Timeline.
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Grouping

Mengumpulkan beberapa obyek untuk dijadikan satu.

Keyframe

Pada dasarnya hampir sama dengan frame. Hanya saja untuk Key frame

lebih menunjukkan untuk satu frame.

Insert

Memasukkan jenis file kedalam bidang kerja SWiSHmax.

Movie

File yang dibuat dalam SWiSHmax.

Object

Benda yang sedang dikerjakan dalam bidang kerja SWiSHmax.

Player

Untuk memainkan animasi yang telah dibuat.

Preview

Melihat hasil yang telah dikerjakan.

Scane

Satu movie merupakan satu Scane.

Time Line

Garis waktu atau pewaktuan yang terdapat dalam SwiSHmax.
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BAB I

PENDAHULUAN

A. DESKRIPSI SOFTWARE 2D ANIMATION

Software 2D Animation banyak ragamnya, mulai dari pengoperasian

yang relatif sulit hingga penggunaan yang users friendly  karena

keterserdiaan fasiltas yang memudahkan. Flash merupakan software

2D animatoin yang banyak, meskipun tingkat pengoperasian flash

relatif rumit. Software 2D Animation lain yang patut diperhatikan

adalah SWISHmax. SWISHmax memiliki kemudahan-kemudahan yang

dapat menghasilkan animasi 2D dengan kompleksitas unsur baik teks,

image, grafik, maupun suara. Animasi SWiSHmax dapat diletakkan

langsung dalam halaman web, dan juga SWiSHmax dapat digunakan

untuk media presentasi.

B. PRASYARAT

Kemampuan awal yang dipersyaratkan untuk mempelajari modul ini

adalah :

1) Peserta diklat memiliki kemampuan untuk mengoperasikan

periferal untuk pembuatan grafi dengan predikat lulus

2) Peserta diklat memiliki kemampuan untuk mengoperasikan

software pengolah gambar vector (digital illustration) dengan

predikat lulus

3) Peserta diklat memiliki kemampuan untuk mengoperasikan

software pengolah gambar raster (digital imaging) dengan

predikat lulus

4) Peserta diklat memiliki pengetahuan untuk melakukan entry data

(grafis) dengan menggunakan Image Scanner
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C. PETUNJUK PENGGUNAAN MODUL

1. Petunjuk Bagi Siswa

Siswa diharapkan mampu berperan aktif dan berinteraksi dengan

sumber belajar yang mendukungnya, karena itu harus diperhatikan

beberapa hal sebagai berikut :

a. Langkah – langkah Belajar

Agar menjadi trampil dan profesional dalam mengoperasikan Software

2D Animation, maka Anda harus mencermati beberapa hal berikut:

1) Apa persyaratan hardware komputer telah sesuai dengan

minimum sistem hardware yang dibutuhkan ?

2) Mulailah belajar dari kegiatan belajar 1, selanjutnya lakukan

belajar secara berurutan ?

3) Seandainya peserta diklat. belum trampil benar dalam mengikuti

praktikum di setiap kegiatan belajar, konsultasikan dengan guru

untuk menambah waktu belajar

4) Jika mengalami kesulitan untuk mengaplikan setiap sub

kompetensi, mintalah bimbingan pada guru

b. Perlengkapan yang Harus Dipersiapkan

Minimum sistem hardware komputer yang dibutuhkan adalah:

1) Windows 95/98/ME/NT4/2000/Xp

2) Pentium II

3) 64 Mb RAM

4) Monitor 800X600 pixel dengan 256 warna
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c. Hasil Pelatihan

Peserta diklat akan mampu membuat animasi 2D dengan memadukan

unsure teks, image, grafis dan suara untuk mendukung pembuatan

proyek software web desain atau software multimedia interaktif.

2. Peran Guru

Peran Guru dalam mengajarkan modul mengoperasikan software 2D

animation antara lain:

a) Memfasilitasi kebutuhan hardware dan software untuk mendukung

kegiatan praktik peserta diklat,

b) Membantu siswa dalam merencanakan tahapan belajar peserta

diklat,

c) Membimbing peserta diklat melalui tugas-tugas pelatihan yang

dijelaskan     dalam tahapan belajar,

d) Membantu siswa dalam memahami konsep dan praktik baru dan

menjawab pertanyaan siswa mengenai proses belajar siswa,

e) Membantu siswa untukmenentukan dan mengakses sumber

tambahan lain yang diperlukan untuk belajar,

f) Mengorganisasikan kegiatan belajar kelompok.

D. TUJUAN AKHIR

1. Peserta diklat mampu mempersiapkan software animasi 2D (2D

animation)

2. Peserta diklat mampu mengenali menu, membuat, membuka,

menyimpan file animasi 2D

3. Peserta diklat mampu melakukan pembuatan animasi 2D

sederhana

4. Peserta diklat mampu mengintegrasikan animasi 2D ke dalam

software multimedia yang lain
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E. KOMPETENSI

KOMPETENSI   : Mengoperasikan software animasi 2 dimensi
KODE   : SWR.OPR.415.(1).A
DURASI PEMELAJARAN : 160 Jam @ 45 menit

A B C D E F  GLEVEL KOMPETENSI
KUNCI 2 3 2 3  2 3  2

KONDISI KINERJA

1. Dalam melaksanakan unit kompetensi ini harus didukung dengan
tersedianya:
§ Software animasi 2D sudah terinstalasiasi
§ User manual software animasi 2D yang digunakan
§ SOP yang berlaku di perusahaan
§ Peralatan dan instrumen yang terkait dengan pelaksanaan unit

kompetensi ini
2. Unit Kompetensi yang harus dikuasai sebelumnya:
§ DTA.OPR.102.(2).A Melakukan Entry Data [Web] dengan

menggunakan Image Scanner (Level 2)
§ SWR.OPR.414.(1).A Mengoperasikan Software Web

3. Pengetahuan yang dibutuhkan:
§ Pengoperasian Komputer
§ Pengoperasian Sistem Operasi sesuai dengan Instruction Manual
§ Objek gambar dan karakteristiknya, serta komposisi gambar dan warna
§ Free-hand drawing
§ On-site training sesuai dengan software yang digunakan

MATERI POKOK PEMELAJARANSUB
KOMPETENSI

KRITERIA
KINERJA

LINGKUP
BELAJAR SIKAP PENGETAHUAN KETERAMPILAN

1. Mempersiapkan
software
animasi 2D (2D
animation)

§ Software 2D
animation telah
terinstalasi dan
dapat berjalan
normal
§User manual

software 2D
animation sudah
disediakan dan
dipahami
§ Perangkat

komputer sudah
dinyalakan,
dengan sistem
operasi dan
persyaratan
sesuai dengan
Installation
manual dan SOP
yang berlaku.
§ Software 2D

animation
dijalankan.

§ Pengenalan
software
2D
animation

§Mengamati
proses
aktifasi
sistem
operasi
dan
software
2D
animation
dengan
seksama

§ Menjelaskan
fungsi software
2D animation

§Menyalakan
komputer sesuai
dengan
Installation
manual dan SOP
§Menjalankan

software animasi
2D sesuai
prosedur. Contoh:
CorelRetas,
Macromedia Flash
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MATERI POKOK PEMELAJARANSUB
KOMPETENSI

KRITERIA
KINERJA

LINGKUP
BELAJAR SIKAP PENGETAHUAN KETERAMPILAN

2. Mengenali
menu,
membuat,
membuka,
menyimpan file
animasi 2D

§ Objek animasi,
menu, dan
interface yang
disediakan
software
animasi 2D
beserta
shortcut-nya
dikenali
berdasarkan
user manual
§ Fitur

pengelolaan file
software
animasi 2D
dapat
digunakan,
seperti:
buat/create/
new,
simpan/save,
buka/ open,
simpan dengan
nama lain/ save
as.
§ Fasilitas siap

pakai seperti
wizard, libraries,
atau template
pada software
animasi 2D
dimanfaatkan
untuk
pembuatan
animasi 2D
sederhana
§ Penyimpanan

file software
animasi 2D
menggunakan
berbagai format
yang dikenal,
seperti: fla,
swf,exe, avi,
dsb.

§ Objek
animasi,
menu dan
interface
software
2D
animation
§ Fitur

pengelola-
an file
software
2D
animation
§ Fasilitas

wizard,
libraries
atau
wizard
§ Teknik

penyimpan
an file
animasi 2D

§Mengenali
objek
animasi,
menu dan
interface
dengan
tepat
§Mengenali

fitur
pengelola
an file
software
2D
animation
dengan
tepat
§Mencermat

i fasilitas
wizard/libr
aries/
template
halaman
web
sederhana
§Mengamati

proses
penyim-
panan file
animasi
2D
dengan
seksama

§ Mengidentifikasi
objek animasi,
menu dan
interface
software 2D
animation
§ Menjelaskan

tujuan
pengelolaan file
software 2D
animation
§ Menjelaskan

manfaat fasilitas
wizard/libraries/
template
halaman web
sederhana
§ Menjelaskan

motif
penyimpanan
file halaman
web dengan
berbagai format

§ Menggunakan
menu dan
interface software
2D animation
secara tepat
§ Menggunakan fitur

pengelolaan file
software 2D
animation sesuai
tujuannya
§ Membuat animasi

sederhana dengan
fasilitas
wizard/libraries/
template
§ Menyimpan file

animasi dengan
menggunakan
format fla,
swf,exe, avi, dsb.

3. Melakukan
pembuatan
animasi 2D

§Gaya animasi
frame by frame
dan tweening di-
pahami dan
diaplikasikan
dalam pembuat-
an animasi 2D
§Objek gambar

lain seperti foto
analog/digital,
dapat
dimanipulasi
dengan meng-
gunakan efek-
efek animasi 2D

§ Gaya
animasi 2D
§ Teknik

manipulasi
objek foto
menjadi
animasi 2D

§Mengamati
gaya
animasi 2D
dengan
teliti
§Mencermat

i proses
manipulasi
objek foto
menjadi
animasi 2D
dengan
seksama

§ Membedakan
gaya animasi
frame by frame
dan tweening
§ Menjelaskan

tahapan proses
manipulasi objek
foto menjadi
animasi 2D

§ Membuat animasi
2D dengan gaya
frame by frame
§ Membuat animasi

2D dengan gaya
tweening
§ Memanipulasi

objek foto menjadi
animasi 2D
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MATERI POKOK PEMELAJARANSUB
KOMPETENSI

KRITERIA
KINERJA

LINGKUP
BELAJAR SIKAP PENGETAHUAN KETERAMPILAN

4. Mengintegra-
sikan animasi
2D ke dalam
multimedia

§Animasi 2D
dapat
diintegrasikan
(di-import) dan
dijalankan di
halaman (objek)
web dengan
menggunakan
software web
§Animasi 2D

dapat
diintegrasikan
(di-import) dan
dijalankan di
halaman (objek)
multimedia
dengan
menggunakan
software
multimedia

§ Teknik
integrasi
animasi 2D
ke halaman
web dan
multi-
media

§Mencer-
mati
proses
integrasi
animasi 2D
ke
halaman
web dan
multimedia
dengan
teliti

§ Menjelaskan
tahapan proses
integrasi animasi
2D ke dalam
halaman web
dan multimedia

§ Mengintegrasikan
animasi 2D ke
halaman web
dengan tepat
§ Mengintegrasikan

animasi 2D ke
halaman
multimedia
dengan tepat

F. CEK KEMAMPUAN

Untuk mengetahui kemampuan awal yang telah Anda miliki, maka

isilah cek lis (√) seperti pada table di bawah ini dengan sikap jujur dan

dapat dipertanggungjawabkan.

Saya dapat
Melakukan Pekerjaan
ini dengan KompetenSub Kompetensi Pernyataan

Ya Tidak

Bila
Jawaban

“Ya”
Kerjakan

Mempersiapkan
software animasi 2D
(2D animation)

Menjalankan software animasi 2D
sesuai prosedur Swishmax Tes

Formatif 1

Mengenali menu,
membuat,
membuka,
menyimpan file
animasi 2D

Menyimpan file animasi dengan
menggunakan format SWF,
HTML, EXE, dan AVI. Tes

Formatif 2

Melakukan
pembuatan animasi
2D

Memanipulasi objek foto menjadi
animasi 2D Tes

Formatif 3

Mengintegrasikan
animasi 2D ke
dalam multimedia

Mengintegrasikan animasi 2D ke
halaman web dengan tepat Tes

Formatif 4

Apabila anda menjawab TIDAK pada salah satu pernyataan di atas,

maka pelajarilah modul ini.
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BAB II

PEMELAJARAN

A. RENCANA PEMELAJARAN SISWA

Kompetensi  : Mengoperasikan software 2D Animation

Sub Kompetensi :

1. Mempersiapkan software animasi 2D (2D animation)

2. Mengenali menu, membuat, membuka, menyimpan file animasi

2D

3. Melakukan pembuatan animasi 2D

4. Mengintegrasikan animasi 2D ke dalam multimedia

Jenis Kegiatan Tanggal Waktu Tempat
Belajar

Alasan
Perubahan

Tanda
Tangan

Guru
Guru
mendemons-
trasikan
ketrampilan
mengoperasikan
softwre animasi
2D SWiSHmax
Siswa
mengoperasikan
tahapan-tahapan
mengoperasikan
softwre animasi
2D SWiSHmax
sesuai dengan
lembar kerja
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B. KEGIATAN BELAJAR

1. Kegiatan Belajar 1 : Mengenal Animasi 2 Dimensi (2D)

a. Tujuan Kegiatan Pemelajaran 1

1) Peserta diklat mampu menjelaskan secara singkat software 2D

SWiSHmax

2) Peserta diklat mampu menjelaskan kebutuhan hardware minimal

untuk mengoperasikan SWiSHmax

3) Peserta diklat mampu melakukan prosedur menginstall SWiSHmax

b.   Uraian Materi 1

1)   Mengenal SWiSHmax

Flash merupakan software yang paling banyak digunakan dalam

memproduksi animasi 2D (2 dimention). Namun dalam peng-

operasian flash agak rumit. Jika ingin membuat animasi flash yang

hebat tanpa menggunakan flash, maka SWiSHmax merupakan salah

satu alat yang tepat. Karena SWiSHmax memiliki kemudahan-

kemudahan yang dapat menghasilkan animasi 2D dengan kompleks

yang indah, baik teks, image, grafik, dan suara dalam waktu yang

singkat.

SWiSHmax memiliki 230 built-in effects seperti: Explode, Vortex, 3D

Spin, Snake, dan masih banyak lagi. SWiSHmax memiliki perangkat

bantu untuk membuat garis, kotak, elips, kurva bezier, gerak

animasi, sprite, dan tombol roll over, dimana semuanya dapat

dilakukan dengan mudah.

SWiSHmax dapat dieksport ke format SWF, HTML+SWF, EXE, dan

AVI sehingga dapat dimainkan di setiap komputer yang memiliki flash

player. SWiSHmax juga dilengkapi dengan SWiSHscript, sehingga
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lebih memudahkan lagi dalam membuat animasi-animasi yang lebih

kompleks lagi. Animasi SWiSHmax dapat diletakkan langsung dalam

halaman web. Selain itu, SWiSHmax dapat digunakan untuk media

presentasi.

2)   Kebutuhan Hardware

Untuk dapat menjalankan SWiSHmax dengan baik diperlukan

persyaratan hardware tertentu. Minimum sistem hardware yang

dibutuhkan adalah:

Ø Windows 95/98/ME/NT4/2000/Xp

Ø Pentium II

Ø 64 Mb RAM

Ø Monitor 800X600 pixel dengan 256 warna

Ø SWiSHmax tidak memerlukan Macromedia Flash untuk diinstall

dalam  sistem

3)    Menginstall SWiSHmax

Untuk menginstall SWiSHmax, tentunya anda harus memiliki software

SWiSHmax terlebih dahulu. Jika anda sudah memiliki software

SWiSHmax, maka anda siap untuk menginstall SWiSHmax.

Adapun cara menginstall SWiSHmax sebagai berikut:

a) Double kilk pada forder SWiSHmax, kemudian klik pada    setup

SWiSHmax format aplication.
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Gambar 1. Jendela Exploring SWiSHmax

b) Klik next dua kali dan klik yes pada jendela perjanjian lisensi.

Gambar 2. Awal Proses Instalasi

c) Kemudian pilih di forder mana SWiSHmax akan diinstal, misalnya

program file/SWiSHmax. Masukkan forder yang dipilih dan klik

Next sehingga ditampilkan proses instalasi.

Gambar 3. Penentuan Folder Instalasi

Jika sudah selesai, pilih Lunch SWiSHmax Now dan klik Close

maka akan tampil jendela license.
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                    Gambar 4. Jendela License

d) Kemudian copy Crack pada software SWiSHmax dan Paste di

program file/SWiSHmax.

Gambar 5. Penyimpanan Forder di Dalam System

e) Double klik pada folder crack, kemudian copy forder SWiSHmax.

f) Setelah itu paste pada folder SWiSHmax yang ada di sistem

sampai kapasitasnya bertambah manjadi 4.237Kb.

g) Selamat!! sekarang anda sudah memiliki SWiSHmax yang

terinstall pada komputer anda.
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Gambar 6. Jendela Ruang Kerja SWiSHmax

c.     Rangkuman 1

1) Software animasi 2D SWiSHmax memiliki kemudahan-kemudahan

yang dapat menghasilkan animasi 2D dari yang sederhana sampai

animasi 2D yang kompleks, memiliki 230 built-in effects dan

Animasi SWiSHmax dapat diletakkan langsung ke halaman web.

2)  Prosedur menginstall SWiSHmax

a) Double kilk pada forder SWiSHmax, kemudian klik pada setup

SWiSHmax format aplication.

b) Klik next dua kali dan klik yes pada jendela perjanjian lisensi.

c) Kemudian pilih di forder mana SWiSHmax akan diinstal,

misalnya program file/ SWiSHmax.

d) Kemudian copy Crak pada software SWiSHmax dan Paste di

program file/SWiSHmax.

e) Double klik pada folder crack, kemudian copy forder

SWiSHmax.
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d.    Tugas 1

Lakukan pengamatan terhadap kinerja dari beberapa jenis komputer

setelah diinstall software animasi 2D SWiSHmax. Jenis komputer

dibedakan Pentium II, Pentium III dan Pentium IV atau jenis

prosessor yang lain.

e.    Tes Formatif 1

1) Jelaskan secara singkat apa yang peserta diklat ketahui tentang

software Animasi 2 Dimensi SWiSHmax.

2) Apa yang dilakukan untuk menyiapkan komputer agar dapat

digunakan untuk membuat Animasi 2 Dimensi dengan software

SWiSHmax.

f.    Kunci Jawaban Formatif

1) Program SWiSHmax adalah program yang digunakan untuk

membuat animasi Flash tanpa menggunakan program Flash.

Berbagai animasi seperti teks, image atau grafik dapat dibuat

dengan mudah. Program ini dapat digunakan untuk mengimport

dan mengekport file sehingga lebih memudahkan dalam

pembuatan animasi. Animasi SWiSHmax didukung oleh

berbagai halaman web, program macromedia Flash.

2) Yang dilakukan untuk menyiapkan komputer agar dapat

digunakan untuk membuat Animasi 2 Dimensi dengan software

SWiSHmax adalah sebagai berikut;

a) Mengetahui persyaratan minimum hardware yang diperlukan

untuk progam  SWiSHmax, sebagai berikut;

• Windows 95/98/ME/NT4/2000/Xp

• Pentium II

• 64 Mb RAM
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• Monitor 800X600 pixel dengan 256 warna

b) Menginstall program SWiSHmax

(1) Double klik pada forder SWiSHmax, kemudian klik pada

setup SWiSHmax format aplication.

(2) Klik next dua kali dan klik yes pada jendela perjanjian

lisensi.

(3) Kemudian pilih di forder mana SWiSHmax akan diinstal,

misalnya program file/ SWiSHmax.

(4) Kemudian copy Crack pada software SWiSHmax dan Paste

di program file/SWiSHmax.

(5) Double klik pada folder crack, kemudian copy forder

SWiSHmax.

g.    Lembar Kerja 1

Tujuan

Pesera diklat mampu menjalankan program SWiSHmax yang sudah

terinstal, sehingga siap untuk melakukan pembuatan animasi.

Alat Dan Bahan

Seperangkat komputer dengan spesifikasi kebutuhan hardware

minimum sebagai berikut;

• Windows 95/98/ME/NT4/2000/Xp

• Pentium II

• 64 Mb RAM

• Monitor 800X600 pixel dengan 256 warna
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 Langkah Kerja

 Lakukan langkah-langkah seperti berikut ini;

o Klik kiri pada Start > Program > SWiSHmax > SWiSHmax.

Seperti pada gambar;

Gambar 7. Menjalankan SWiSHmax dari Menu Start

o Jika sudah ada pada Desktop, tinggal klik kiri dua kali atau klik

kanan kemudian Open.

Seperti pada gambar;

Gambar 8. Menjalankan SWiSHmax dari Desktop
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o Jika dari Explorer, masuk pada C drive > Program Files >

SWiSHmax > Cari SWiSHmax yang berektensi aplikasi kemudian

klik kiri dua kali.

Seperti pada gambar;

Gambar 9. Menjalankan SWiSHmax Windows
Explorer
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2. Kegiatan Belajar 2 : Memulai SwiShmax dan Mengenali Menu-

menu pada SWiSHmax

a. Tujuan Kegiatan Pembelajaran 2

1) Peserta diklat mampu melakukan operasi file, antara lain membuat

file baru, membuka file, menyimpan file, mencoba file, dan

mengubah jenis file.

2) Peserta diklat mampu mengoperasikan fungsi-fungsi yang terdapat

pada main menu dan sub menu.

b. Uraian Materi 2

1) Memulai SWiSHmax

a) Membuat File Baru

Untuk membuat file baru di SWiSHmax ada dua cara yang dapat

dilakukan, yaitu :

• Menutup file sebelumnya

Untuk dapat membuat file baru, masuklah ke menu File > New

atau dengan menekan tombol Ctrl+N. Jika file sebelumnya belum

disimpan dan akan membuat file baru, maka akan tampil jendela

informasi. Kemudian pilih Yes jika ingin menyimpan file tersebut,

No untuk tidak menyimpan file, dan Cancel untuk tidak membuat

file baru.

Gambar 10. Jendela informasi
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Masuklah ke menu File > New Windows atau cukup dengan

menekan tombol Ctrl+Shift+N. Dengan melakukan hal ini, file

sebelumnya tidak akan terganggu namun sistem recourse pada

komputer akan berkurang sebab anda menggunakan dua aplikasi

SWiSHmax sekaligus.

Gambar 11. Jendela pada desktop

b) Membuka File

Untuk membuka file, masuklah ke Menu > Open atau cukup dengan

menekan tombol Ctrl+O. Untuk membuka file yang diinginkan, cukup

pilih file tersebut dan klik open.

Gambar 12. Jendela open file

c) Menyimpan File

Untuk menyimpan file, ada dua cara yang dapat dilakukan yakni;

• Menyimpan file yang belum pernah disimpan sebelumnya.

Masuklah ke menu File > Save As, kemudian akan keluar jendela

Save As. Anda dapat mengetikan untuk memberi nama file yang
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akan anda simpan. Kalau tidak mengetikan nama, maka dengan

sendirinya nama file akan tersimpan dengan nama movie1.

Gambar 13. Jendela save as

• Menyimpan file yang sudah disimpan sebelumnya.

Masuklah ke menu File > Save atau cukup menekan tombol

Ctrl+S. Dokumen anda akan langsung tersimpan.

d) Memasukkan Jenis File

Untuk dapat memasukkan jenis file tertentu seperti file gambar, lagu,

teks dan lainnya, dapat digunakan fasilitas Import dari SWiSHmax.

Caranya masuklah ke menu File > Import....

      Gambar 14. Jendela import
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e) Mengubah Jenis File

Untuk mengubah jenis file, anda dapat menggunakan fasilitas Export.

Masuklah ke menu File > Export, maka akan tampil sub menu

sebagai berikut;

• SWF, SWF... digunakan untuk membuat file berekstensi .swf yang

merupakan file standart Flash.

• HTML, HTML+SWF... dengan demikian anda dapat langsung

memasukkan ke file HTML. Sehingga dapat langsung digunakan

dalam pembuatan web.

• EXE, EXE... dengan format ini, maka file dapat langsung digunakan

di komputer tanpa memiliki program SWiSHmax.

• AVI, AVI...merupakan file untuk film atau video.

• Copy HTML to Clipboard, sama seperti HTML namun disini hasilnya

bukan disimpan ke dalam file, namun disimpan ke clipboard.

Gambar 15. Jendela export

f)  Mencoba Dokumen

Untuk mencoba hasil animasi yang telah anda buat, ada tiga langkah

yang dapat dilakukan, yakni;
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(1) Masuklah ke menu File > Test.

Gambar 16. Jendela test

• In Player : Digunakan untuk mencoba dokumen yang sudah

selesai anda kerjakan di Flash Payer.

• In Browser : Digunakan untuk mencoba dokumen yang sudah

anda kerjakan di browser anda.

• Report : Digunakan untuk menyajikan laporan file .SWF yang

dihasilkan oleh dokumen anda.

(2) Menggunakan fasilitas Control Toolbar yang ada di jendela ruang

kerja SWiSHmax.

(3) Menekan tombol Ctrl+P.
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KlikPlay

Gambar 17. Jendela ruang kerja SWiSHmax

2) Tampilan SWiSHmax

Sebelum memulai menggunakan SWiSHmax, perlu mengetahui ruang

kerja SWiSHmax. Ruang kerja yang ada biasanya terdiri atas menu,

toolbar, dan komponen-komponen lain.

Ruang kerja SWiSHmax terdiri atas komponen berikut;

• Main Menu

• Toolbox

• Toolbar-toolbar termasuk toolbar standart, insert, dan control.

• Panel-panel termasuk panel Timeline, Outline, Layout, dan text.

• Status Bar.

a) Menu Utama

Main menu adalah menu utama dari SWiSHmax yang sangat penting

bagi pengguna. Didalamnya terdapat menu-menu yang sering

digunakan. Main menu terletak di bagian teratas window SWiSHmax.
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Standart Toolbar  Main Menu                   Control Toolbar

Stack                                     Insert Toolbar      Timeline Panel

Outline Panel  Jendela Movie                     Movie Panel

                       Zoom Control       Bidang kerja    Status Bar

                          Toolbox                  Layout Panel

Gambar 18 jendela tampilan SWiSHmax

• Menu File

Menu File memiliki berbagai submenu yang memiliki banyak fungsi

tertentu. Berikut ini penjelasan submenu yang ada, fungsi-fungsi

yang disediakan sebagai berikut;
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Gambar 19. Jendela menu File

• Menu Edit

Menu Edit digunakan untuk membuat perubahan suatu movie,

misalnya copy paste obyek.

Gambar 20. Jendela Menu Edit

• Menu View

Memberikan fasilitas untuk merubah tampilan movie, serta

mengatur toolbar yang ditampilkan.
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Gambar 21. Jendela Menu View

• Menu Insert

Menu Insert ini memberikan fasilitas untuk menambahkan sesuatu

pada movie seperti text, button, sprite dan sebagainya.

Gambar 22. Jendela Menu Insert

• Menu Modify

Menu Modify memberikan fasilitas untuk mengubah properti dari

obyek yang sekarang sedang diseleksi.
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Gambar 23. Jendela menu Modify

• Menu Control

Menu Control memberikan fasilitas untuk mengontrol bagaimana

movie dimainkan dan di-preview di dalam ruang kerja SWiSHmax.

Gambar 24. Jendela Menu Control

• Menu Tools

Menu Tools memberikan fasilitas untuk mengatur setting untuk

aplikasi SWiSHmax secara keseluruhan dan menambahkan perintah

pada user interface SWiSHmax.

Gambar 25. Jendela Menu tools



27

• Menu Panels

Menu Panels memberikan fasilitas untuk dapat memilih untuk

menampilkan atau menyembunyikan panel yang diinginkan.

Gambar 26. Jendela Menu Panels

• Menu Help

Pada menu ini anda dapat mengakses Help SWiSHmax, tutorial

SWiSHmax,  link ke situs SWiSHmax, link ke forum support, link

mengenai Macromedia Flash, dan informasi singkat mengenai

SWiSHmax itu sendiri.

Gambar 27. Jendela Menu Help

b) Standart Toolbar

Toolbar merupakan kumpulan icon-icon. Standart toolbar merupakan

toolbar utama.
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Gambar 28. Jendela standart toolbar

Fungsi dari icon-icon tersebut antara lain sebagai berikut:

New [Ctrl+N]

Membuat dokumen baru

Bring Forword

Memindahkan suatu obyek satu

langkah menuju atas stack

Open [Ctrl+O]

Membuka dokumen (.swi)

Send Backward

Memindahkan suatu obyek satu

langkah menuju bawah obyek

Save [Ctrl+S]

Menyimpan dokumen

(.swi)

Bring to Font

Memindahkan suatu obyek ke

urutan paling atas stack

Cut [Ctrl+X] Menghapus

obyek dan Menyimpan di

clipboard

Send to back

Memindahkan suatu obyek ke

urutan paling bawah stack

Copy [Ctrl+C]

Menyalin Obyek ke

clipboard

Undo [Ctrl+Z]

Membatalkan langkah terakhir

Paste [Ctrl+V]

Menyalin obyek dari

clipboard

Redo [Ctrl+Y]

Mengembalikan langkah yang

dilakukan oleh perintah undo

Delete [Del]

Menghapus obyek

Help topics [F1]

Menampilkan jendela help

Fine [Ctrl+f]

Mencari obyek

Contect-sensitif Help

Menampilkan help pada bagian

tertentu
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c) Insert Toolbar

Insert toolbar merupakan gabungan beberapa icon yang digunakan

untuk menyisipkan suatu obyek tertentu ke dalam dokumen.

Gambar 29. Jendela Insert toolbar

Fungsi dari icon-icon tersebut antara lain sebagai berikut;

Insert scane

Menambah scene baru

Insert Content

Menyisipkan suatu file/

dokumen

Insert text

Memasukkan tulisan/ text

Insert button

Membuat obyek button

(tombol)

Insert Image

Menyisipkan gambar dari

file gambar

Insert Sprite

Membuat obyek sprite

d) Control toolbar

Control Toolbar merupakan toolbar untuk pengaturan movie yang

sudah jadi dan siap untuk dijalankan.

Gambar 30. Jendela Control Toolbar

Fungsi dari icon-icon tersebut antara lain sebagai berikut:
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Stop

Menghentikan movie yang

sedang berjalan

Rewind

Menuju frame pertama pada

Preview Frame

Play

Memainkan movie

Step Back

Menuju frame sebelumnya

Pada mode Preview Frame

Play Scane

Memainkan hanya scane

Yang aktif

Preview Frame

Mengaktifkan/

mengnonaktifkan mode

Preview Frame. Agar icon

icon Review, Step Back, Step

or ward dan Go To End bisa

bekerja, fasilitas ini harus

dalam kondisi on

Play Effect

Memainkan hanya effect

Yang aktif

Go To End

Menuju frame terakhir pada

Mode Preview Frame

Step Forword

Menuju frame berikutnya

Pada mode Preview Frame

e) Grouping Toolbar

Grouping Toolbar merupakan toolbar untuk mengabungkan beberapa

obyek menjadi suatu group obyek atau mengkonversi suatu bentuk ke

bentuk obyek yang lain.

Gambar 31. Jendela Grouping Toolbar
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Fungsi dari icon-icon tersebut antara lain sebagai berikut:

Group as group

Menggabungkan beberapa

Obyek menjadi satu obyek

Group

Convert to Button

mengubah suatu obyek

menjadi obyek tombol

(button)

Group as Button

Menggabungkan beberapa

Obyek menjadi satu buah

Obyek button

Convert to Sprite

Mengubah suatu obyek

menjadi obyek sprite

Group as Sprite

Menggabungkan beberapa

Obyek menjadi satu buah

Obyek sprite

Break into Shapes

Memisahkan obyek shapes

yang kompleks menjadi

shape-shape tersendiri

Group as Shape

Menggabungkan beberapa

Obyek menjadi satu buah

Obyek shape

Break into letters

Memisahkan obyek texs

yang kompleks menjadi

text-text tersendiri.

UngroupMemisahkan

komponen- Komponen di

dalam suatu Obyek group

menjadi obyek-obyek

tersediri

Break into pieces

Memisahkan obyek

kelompok menjadi obyek

yang lebih kecil

f)  Export Toolbar

Export Toolbar merupakan toolbar untuk mengeksport file SWI yang

dihasilkan oleh SWiSHmax menjadi format file lainnya.

Gambar 32. Jendela Export toolbar
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Fungsi dari icon-icon tersebut antara lain sebagai berikut:

Export to SWF

Menghasilkan file SWF,

yang Merupakan format

file Keluaran Flash

Export HTML to clipboard

Menghasilkan file HTML yang ada

di clipboard ke dalam Halaman

web.

Export to HTML+SWF

Menghasilkan file HTML

dan SWF, yaitu berguna

untuk Menampilkan di

browser

Test in Browser

Mencoba dokumen yang  sudah

dikerjakan di browser.

Export to EXE

Menghasilkan file EXE,

yang Merupakan file

project

Test in Player

Mencoba dokumen yang

dikerjakan di flash Player

Export to AVI

Menghasilkan file AVI,

yaitu Suatu format file

video yang Umum

digunakan

Report

Digunakan untuk menyajikan file

.SWF yang dihasilkan oleh

dokumen

g) Stack

Stack merupakan urutan penyusunan cara penampakan (display)

obyek-obyek pada ruang kerja di scane yang bersangkutan.

h) Timeline Panel

Timeline merupakan rangkaian urutan-urutan waktu eksekusi suatu

movie. Dengan Timeline dapat digunakan untuk membuat movie

dengan pengaturan waktu.
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i)  Outline Panel

Outline Panel menampilkan struktur dari movie yang sedang

dikerjakan. Struktur ini dari atas menuju kebawah, sehingga seperti

pohon.

j)  Layout Panel

Layout Panel memiliki tiga komponen utama, yaitu;

• Bidang kerja

Bidang kerja adalah layar utama untuk menggambar dan

memainkan movie yang telah dibuat. Bagian putih adalah bidang

kerja dari SWiSHmax.

• Toolbox

Toolbox digunakan untuk menggambarkan di bidang kerja.

Gambar 33. Jendela Toolbox

Fungsi dari icon-icon tersebut antara lain sebagai berikut:
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Select/ scale

Memilih, memindahkan,

dan Mengubah ukuran

obyek

Motion Path

membuat animasi pergerakan

pada suatu obyek

Reshape

Memilih, memindahkan,

dan Mengubah bentuk

obyek Berbentuk image

Line

Menggambar garis lurus

Fill Transform

Mengubah isi dari suatu

obyek tanpa mengubah

obyek itu sendiri.

Bezier

Menggambar dengan

menghubungkan titik-titik.

Pencil

Menggambar bebas

Ellipse

Menggambar ellips atau

lingkaran

Rectangle

Menggambar persegi

panjang Atau bujur

sangkar.

Auto Shape

Menggambar beberapa

bentuk tertentu yang sudah

disediakan

Pan

Memindahkan bidang

kerja

Text

Membuat tulisan/ text.

Zoom

Memperbesar bidang kerja

k)  Zoom Control

Zoom Control berfungsi mirip dengan kaca pembesar, yaitu berfungsi

untuk membesarkan atau mengecilkan bagian-bagian tertentu pada

bidang kerja.
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l)  Panel

Panel digunakan untuk menampilkan dan mengubah informasi suatu

elemen SWSHmax.

m) Status Bar

Status bar menampilkan status dan panduan kecil untuk bagian-bagian

yang sedang disorot/ aktif, perintah yang sedang dijalankan dan

lainnya.

3) Elemen-elemem SWiSHmax

Elemen-elemen pada SWiSHmax merupakan komponen-komponen

yang digunakan untuk membuat suatu animasi. Elemen tersebut saling

kerjasama untuk membuat animasi agar terlihat hidup dan tidak

terlihat patah-patah atau sambungan-sambungan. Animasi tersebut

pada dasarnya dari bentuk-bentuk statik (tidak bergerak) yang disusun

sehingga menjadi bentuk yang dinamis.

Pada SWiSHmax, terdapat beberapa elemen utama yang digunakan,

yakni: Movie, Scane, Obyek, Timeline, Frame, Efek, Action, Event,

Script

a)  Movie

Setiap animasi yang dibuat merupakan sebuah movie. Jadi jika anda

membuka suatu file berarti anda membuka sebuah movie. SWiSHmax

akan menampilkan movie panel disebelah kanan Layout Panel. Jika

belum ada, anda dapat mengaktifkan dengan memilih menu Panels >

Movie, kemudian beri tanda centang (V) berarti Movie Panel aktif.
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Gambar 34. Jendela Movie Panel

Pada Movie Panel diatas terdapat beberapa tab yakni, Tint, Align,

Guides, Content, Export, Debug, Movie, Shape, tranform. Aktifkanlah

Movie dengan cara klik pada tab bertuliskan Movie, maka akan

mengantar ke Movie Panel.

• Width & Height

Width & Height merupakan pengaturan lebar dan tinggi bidang

kerja yang digunakan dalam ukuran pixel. Nilai ini digunakan

terutama jika mengeksport suatu movie ke dokumen HTML.

• Frame Rate

Frame Rate merupakan ukuran kecepatan movie dalam banyaknya

frame per detik. Semakin besar nilai Frame Rate berarti semakin

banyak frame yang digunakan dalam satuan detik sehingga movie

semakin cepat pula berjalan. Jika Frame rate semakin kecil maka

semakin lambat pula movie berjalan. Nilai default untuk Frame rate

adalah 12 frame/detik, yang berarti setiap detiknya ada 12 frame

yang dijalankan.
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• Background Color

Background Color digunakan untuk pengaturan (background) dari

movie. Warna latar belakang ini dapat diubah-ubah sesuai dengan

keperluan dengan menekan tombol                              .

• Stop playing and at movie

Pilihan ini digunakan, jika diinginkan obyek yang digerakkan oleh

sebuah efek movie berhenti dan tidak melakukan perulangan lagi.

Ini dilakukan dengan memberi tanda centang pada

b)  Scane

Scane merupakan bagian-bagian kecil dari suatu movie. Dalam suatu

scane terdapat bermacam-macam obyek. Jika ingin membuat scane

yang baru dapat dilakukan dengan:

• Masuklan ke menu Insert > Scane     .

• Klik icon      yang berada di Insert Toolbar.

Untuk menampilkan Scane Panel, bisa dilakukan dengan:

• Jangan memilih satu atau lebih obyek di Layout Panel.

• Pilih Scane yang diinginkan di Outline Panel.

Gambar 35. Jendela Scane
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Keterangan pada jendela Scane :

• Name

Name digunakan untuk memberi nama suatu scane yang

tampilannya bisa dilihat pada stack atau Outline Panel. Ini juga

akan membantu dalam action ‘Goto frame’.

• Color

Color digunakan untuk memberi warna pada background scane

dengan merubah Color Selector. Jika menggunakan suatu nilai alfha

kurang dari 100%, maka dapat mewarnai background movie. Jika

menggunakan suatu nilai alfa 0% (transparan yang ada di default

setting), scane akan mempunyai warna yang sama dengan movie

default.

• On Click

Seting untuk action pada mouse selama scane;

Ø Do nothing

Do nothing merupakan tidak ada gerakan pada obyek.

Ø Go to Next Scane

Go to Next Scane merupakan perintah untuk berganti ke scane

selanjutnya.

Ø Go to Link (URL)

Go to Link (URL), memberikan URL pada scane. Sehingga

sewaktu scane di klik saat movie sedang berjalan, maka akan

menghubungkan pada HTML.

• Label scane

Label scane merupakan label frame pertama pada scane dengan

nama label scane.
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• Use as anchor

Use as Anchor merupakan Scane yang lebih spesifik yang

digunakan dalam halaman web. Sehingga memungkinkan untuk

forward dan Back tombol pada web browser yang digunakan di

navigasi pada movie.

• Use this scane as a background

Use this scane as a background merupakan seting scane untuk

ditampilkan dibelakang scane berikutnya. Pada seting ‘Stop at And’

dan ‘Go to Next Scane’ tidak akan dijalankan.

• Stop playing at end of movie

Secara otomatis akan menghentikan movie saat akhir scane.

• Apply these setting to all scanes

Secara otomatis akan merespon properties pada scane ke seluruh

scane movie dengan menggunakan background yang telah dipilih.

c)  Objek

Objek merupakan benda-benda yang ada di dalam suatu scane. Pada

dasarnya objek dapat dibedakan menjadi dua jenis yakni;

• Simple Object

• Complex Object

Simple Object

Simple Object merupakan objek-objek yang tidak memiliki komponen-

komponen di dalamnya. Objek-objek yang merupakan simple object

yaitu;

o Objek Shape

Obyek shape merupakan bentuk yang paling dasar dari simple

object. Object Shape ada dua jenis, yakni;
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ü Objek shape yang berbentuk bitmap, yaitu objek yang berasal

dari file gambar bitmap seperti JPG, GIF, atau bitmap. Objek ini

diambil dari gambar yang sudah ada, yaitu dengan

menggunakan icon ‘Insert Image’ dari Insert Toolbar.

ü Objek shape yang berbentuk vektor, yaitu objek yang digambar

langsung pada SWiSHmax. Objek shape ini, jika diperbesar

gambarnya tidak akan pecah berbeda dengan gambar dari

bitmap. Objek semacam ini dapat dibuat dari icon-icon yang

terdapat pada Toolbox, yaitu; Line, Pencil, Bezier, Rectangle,

Ellips, dan Auto Shape.

Selain itu, anda dapat membuat suatu objek shape dengan

menggunakan;

o Group as Shape

Dengan menggabungkan beberapa objek Text atau shape sehingga

menjadi satu bentuk gabungan dari objek-objek tersebut. Untuk

menggunakannya, bisa dengan cara berikut;

ü Menggunakan icon ‘Gruop as Shape’ dari Grouping Toolbar.

ü Masuklah menu Modify > Grouping > Group as Shape.

Jika objek yang digabungkan bukan berupa Text atau shape,

misalnya objek gambar. Maka objek-objek tersebut bukan

digabungkan menjadi suatu bentuk tersendiri, namun menjadi

objek Shape yang masing-masing berdiri sendiri.

Ada beberapa catatan yang perlu diperhatikan dalam penggunaan

Group as Shape, yakni;

ü Jika ingin menggabungkan objek yang style-nya sama, dimana

objek yang satu berada di dalam objek yang lain, maka objek

yang berada di dalamnya akan hilang.
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(a) Sebelum di-Group             (b) Setelah di-Group

     Gambar 36. Group to Shape dari dua buah objek

ü Jika ingin menggabungkan objek yang saling berpotongan

dengan style yang sama, maka jika objek-objek itu

digabungkan, perpotongan objek-objek tersebut akan

dihilangkan.

       (a) Sebelum di-Group             (b) Setelah di-Group

Gambar 37. Group to Shape dari objek yang saling

berpotongan

ü Jika ingin menggabungkan objek-objek yang saling berpotongan

namun dengan style yang berbeda, maka jika objek-objek

tersebut digabungkan objek tersebut tidak saling terpotong,

namun garis-garis batas keduanya akan terlihat sehingga objek-

objek tersebut  tidak terlihat saling menimpa tapi seakan-akan

berada di urutan yang sama pada Layout Panel.
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       (a) Sebelum di-Group             (b) Setelah di-Group

Gambar 38. Group to Shape dari objek dengan style berbeda

Objek-objek yang memiliki efek dan even tidak bisa digabungkan

dengan menggunakan perintah Group as Shape. Agar bisa

digabungkan, efek atau event yang ada pada objek harus

dihilangkan dahulu.

o Import File

Import File pada dasarnya mengambil file dalam format file yang

disimpan oleh software tersebut. Untuk mengimport suatu file,

pilihlah menu File > Import. Kemudian akan ditampilkan suatu

jendela Import File, pilih jenis file yang diinginkan lalu klik tombol

Open.

Jenis file yang dapat di-Import adalah sebagai berikut;

ü Images

§ Windows bitmap (*.bmp; *.dib)

§ GIF image (*.gif)

§ JPEG image (*.jpg; *.if, *.jpeg)

§ PNG image (*.png)

ü Graphics (vektor)

§ Windows Metafile (*.wmf)

§ Enhanced Metafile (*.emf)
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§ Flash Graphics (*.swf both compressed and uncompressed)

Pengaturan shape dapat diatur dari Shape Panel. Pengaturan agak

berbeda antara objek Shape yang berbentuk bitmap dengan yang

berbentuk vektor.

v Untuk bentuk Bitmap

Gambar 39. Shape Panel pada objek bitmap

§ Name

Nama ini digunakan untuk memberi nama objek di outline Panel

agar tidak kesulitan membedakan dengan objek yang lain.

§ Line

Line digunakan untuk membuat garis pinggir pada gambar.

Bentuk garis dapat diatur dari kotak line e

serta  ukuran garis dengan                dan untuk merubah

warna garis dengan merubah      .

Gambar 40. Objek bitmap dengan garis tepi
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§ Fill Style

Fill Style digunakan untuk pengisian shape. Gambar diatas Fiil

Style berbentuk Tiled Image                    . Jika tombol ini di

klik, akan didapati beberapa jenis Fill Style, antara lain;

Ø None, Dengan tidak menggunakan warna untuk mengisi

shape sehingga yang ditampilkan hanyalah kerangka objek

saja.

Ø Solid, menggunakan suatu warna untuk mengisi shape.

Ø Linear Gradient, menggunakan beberapa warna yang

berbeda dan disusun secara linear.

Ø Radial Gradient, menggunakan beberapa warna yang

berbeda dan disusun secara radial.

Ø Tiled Image, Jika gambar yang digunakan tidak memenuhi

shape atau ada yang sisa ruang, maka akan dibuat gambar

berbentuk tile.

Ø Clipped image, Jika gambar yang digunakan untuk

memenuhi shape terlalu kecil, gambar ini akan diperbesar

untuk dapat memenuhi shape.

Selain itu saat Fill Style berupa Tiled Image dan Clipped image ,

pada di Fill Style akan terdapat:

Properties

Jika tombol ini diaktifkan, maka akan muncul Jendela Image

Propeties.
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Gambar 41. Jendela Image Properties

Pengaturan disini hanya dijelaskan penggunaan pada Fill Style

bentuk Tiled image dan Clipped image saja. Karena pengaturan

ini akan menghasilkan bentuk yang lebih baik pada objek

bitmap.

Keterangan dari gambar diatas:

Image Tranform

X dan Y

Digunakan untuk mengatur titik tengah (pusat) objek. Sebagai

contoh nilai X dan Y sebesar (150,50) akan seperti pada gambar

berikut.

        (a) Tiled image                      (b) Clipped image

Gambar 42. Objek bitmap dengan titik pusat 150,50)
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W dan H

Digunakan untuk mengatur nilai lebar (W) dan tinggi (H) dari

objek bitmap.

X-scale dan Y-scale

Nilai X-scale          digunakan untuk mengubah ukuran suatu

objek secara horisontal.

Nilai Y-scale           digunakan untuk mengubah ukuran suatu

objek secara vertikal.

Nilai yang dimasukkan dalam persen (%), sehingga 100%

berarti melambangkan ukuran normal. Jika nilai yang

dimasukkan lebih kecil maka objek akan lebih kecil dan

sebaliknya, jika nilai yang dimasukkan lebih besar maka objek

juga akan lebih besar.

Disini nilai X-scale dan Nilai Y-scale akan mempengaruhi

perubahan pada W dan H. Jika X-scale dan Nilai Y-scale dalam

%, maka W dan H dalam pixel. Nilai X-scale akan berkaitan

dengan nilai W, dan nilai Y-scale berkaitan dengan nilai H.

Sebagai contoh, titik X dan Y (0,0) dan scale sebesar 50% akan

terlihat pada gambar.

       (a) Tiled image                      (b) Clipped image

 Gambar 43. Objek bitmap titik (0,0) scale 50%
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X-Angle dan Y-angle

Ini digunakan untuk mengubah sudut pemutaran dari objek.

Nilai X-Angle                digunakan untuk mengubah sudut

pemutaran objek pada sumbu horisontal dan           Y-Angle

digunakan untuk mengubah sudut pemutaran objek pada

sumbu vertikal. Nilai yang dimasukkan dalam derajat (0) searah

dengan jarum jam, nilai 00 berarti objek tidak diputar.

Sebagai contoh, untuk pemutaran sudut pemutaran sebesar 500

pada X-Angle dan Y-Angle akan terlihat pada gambar.

         (a) Tiled image                      (b) Clipped image

Gambar 44. Objek dengan X-Angle dn Y-Angle 50%

Uniform

Untuk Uniform yang berada di samping X-Scale dan Y-Scale

digunakan jika diinginkan ukuran menurut sumbu horisontal dan

vertikal sama, jika diinginkan ukuran menurut sumbu horisontal

dan vertikal berbeda hilangkanlah tanda centang.

Untuk Uniform yang ada disamping X-Angle dan Y-Angle

digunakan jika ada tanda centang berarti permutaran objek

dengan objek yang tetap proposional, namun jika dihilangkan

tanda centang maka nilai X-Angle dan Y-Angle akan berbeda

serta menginginkan objek menjadi miring.

Always Fit

Jika pilihan ini diaktifkan, obyek gambar tidak bisa diubah-ubah

keadaannya, yaitu tetap memenuhi shape.
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Reset

Jika pilihan ini diaktifkan maka keadaan gambar pada shape

akan seperti semula, yakni kembali ke keadaan sebelumnya.

Export options

Preload

Digunakan untuk menentukan kapan gambar akan dipanggil ke

memori komputer. Pilihannya sebagai berikut;

Ø Disabled

Berarti tidak adanya preload. Sehingga objek gambar yang

perlu dipanggil, dipanggil tepat pada bagian tersebut akan

digunakan. Ini akan menyebabkan animasi akan berjalan

tersendat-sendat.

Ø Before Scane

Preload objek gambar akan dilakukan sebelum suatu movie

dimulai. Objek akan dipanggil sebelum scane dimulai.

Ø Before Movie

Preload objek gambar akan dilakukan sebelum suatu movie

dimulai. Objek akan dipanggil sebelum movie dimulai.

Ø At Preload frame

 Preload dilakukan dengan mengacu pada action Preload

Content dan If Frame loaded.

Ø Abjek Default

Pengaturan preload image diatur dari Objek Export Panel.

Don’t Smooth

Jika pilihan ini diaktifkan, maka objek gambar tidak akan

diperhalus ketika diubah bentuknya. Akan bagus dilakukan saat

gambar diperkecil, namun akan memperburuk gambar jika

gambar diperbesar.
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8 Bit/pixel ZIP, 16 Bit/pixel ZIP dan 32 Bit/pixel ZIP

Jika dipilih ZIP Compress dan image yang asli pada 16 Bit warna

atau lebih, maka dapat dipilih untuk menyimpan dalam format 8

atau 16 Bit/pixel. Semakin besar ukuran Bit/pixel, maka gambar

yang dihasilkan akan semakin bagus.

JPEG Compression

Jika memilih JPEG Compress, maka dapat digunakan alternatif

lain yakni akan menggunakan JPEG Compress dari hasil

mengimport gambar atau menggunakan fasilitas dari SWiSHmax

untuk recompress image lagi dengan kualitas level yang dapat

diatur sendiri. Beberapa image harus di recompress karena ada

yang menggunakan progressive JPEG encoding, atau file yang

asli tidak di JPEG compress.

Recompress JPEG

Jika memilih JPEG Compress dan juga memilih Recompress

JPEG image, maka dapat diatur kualitas  image. Semakin besar

nilai pengaturan, maka kualitas image akan semakin bagus pula

dan sebaliknya semakin kecil nilai pengaturannya semakin jelek

kualitas imagenya.

Width, Height, Bit/pixel, dan size (bytes)

Fasilitas ini digunakan untuk mengetahui lebar, tinggi, ukuran

Bit/pixel dan ukuran file dari image.

Adjust Appearance

Contrast

Contrast ini digunakan untuk melakukan penyesuaian

keseluruhan kontras gambar.
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Brightness

Brightness digunakan untuk melakukan penyesuaian gelap

terangnya gambar.

Saturasition

Saturation digunakan untuk pengaturan penyesuaian kejenuhan

warna gambar.

Hue

Hue digunakan untuk melakukan penyesuaian warna gambar,

dengan mengubah warna dapat menambah suatu warna ke

keseluruhan gambar.

Resolution

Resolution digunakan untuk melakukan penyesuaian resolusi

pixel pada gambar suatu resolusi yang asli.

Transparency

Transparency disediakan untuk membuat gambar menjadi

buram. Ketika pilihan ini dipilih, maka dapat membuat warna

yang spesifik dari gambaran transparan. Ini hanya digunakan

pada objek-objek yang padat. Jika diaktifkan, akan muncul

pilihan transparant color                      untuk memilih warna

yang akan dibuat tranparan.

Kotak transparan                    dipakai untuk menentukan nilai

toleransi transparasi dari warna yang dipilih. Nilai

toleransi yang digunakan antara 0 sampai 255. Semakin kecil

nilainya, maka warnanya semakin padat dan

sebaliknya semakin besar nilainya maka warna semakin bersifat

transparan.
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Gambar 45. Jendela pengaturan transparansi

Fit to shape

Membuat objek untuk memenuhi shape.

Reset Tranform

Untuk mereset ke keadaan semula, sebelum di klik Fit to shape.

Icon-icon

Digunakan untuk memilih image baru.

Digunakan untuk mengisi image dari disk.

Digunakan untuk memilih bentuk objek yang sudah ada.

v Untuk bentuk Vektor

Gambar 46. Shape Panel pada objek vektor

Name
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Digunakan untuk memberi nama objek sehingga mudah dikenali

dan mudah membedakan dengan yang lain di Outline Panel.

Line

Line digunakan untuk membuat garis pinggir pada gambar.

Bentuk garis dapat diatur dari kotak line                     serta

ukuran garis dengan                dan untuk merubah warna garis

dengan merubah      .

Gambar 47. Objek vektor dengan garis tepi

Fill Style

Fill Style digunakan untuk pengisian shape. Gambar diatas Fiil

Style berbentuk Tiled Image                    . Jika tombol ini di

klik, akan didapati beberapa jenis Fill Style, antara lain;

§ None, Dengan tidak menggunakan warna untuk mengisi

shape sehingga yang ditampilkan hanyalah kerangka objek

saja.

§ Solid, menggunakan suatu warna untuk mengisi shape.
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§ Linear Gradient, menggunakan beberapa warna yang

berbeda dan disusun secara linear.

§ Radial Gradient, menggunakan beberapa warna yang

berbeda dan disusun secara radial.

§ iled Image, Jika gambar yang digunakan tidak memenuhi

shape atau ada yang sisa ruang, maka akan dibuat gambar

berbentuk tile.

§ Clipped image, Jika gambar yang digunakan untuk

memenuhi shape terlalu kecil, gambar ini akan diperbesar

untuk dapat memenuhi shape.

Jika menggunakan pilihan Tiled image atau Clipped image,

maka akan muncul gambar bitmap sehingga pengaturan

bukan dalam bentuk vektor.

Gambar 48. Contoh gambar Clipped image

Solid

Solid menggunakan sebuah warna untuk mengisi objek shape,

sehingga dapat dipilih warna yang diinginkan.

Gambar 49. solid pada Fill Style

Linear Gradient
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Linear Gradient digunakan untuk membuat warna-warna yang

berbeda berbentuk bergaris-garis pada suatu objek gambar

vektor. Dengan menggunakan Linear Gradient ini seolah-olah

seperti membuat silinder, dengan mengatur warna-warna.

Pengaturan warna dapat dilakukan dengan mengatur segitiga

yang berada didaerah pewarna. Segitiga dibagian kiri mewakili

bagain kiri objek dan segitiga di bagian kanan mewakili bagian

kanan objek. Segitiga tersebut dapat diubah warnanya dengan

klik kiri pada segitiga tersebut dan pilih warna yang diinginkan.

Gambar 50. Contoh gambar Linear Gradient

Jika tombol Properties ditekan, akan muncul suatu jendela baru,

yakni Gradient Properties

Gambar 51. Jendela Gradient Properties

Pada dasarnya, isi dari jendela hampir sama dengan isi jendela

pada Fill Properties di bagian gambar bitmap. Hal yang perlu

diperhatikan bahwa yang diubah-ubah pengaturannya (X,Y,W,H,

scale & rotare) bukan kerangka dari objek tersebut tapi isi dari

kerangka objek.
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Radial Gradient

Radial Gradient untuk membuat warna-warna yang berbeda

yang secara radial berbentuk lingkaran pada suatu objek vektor.

Penggunaannya seperti pada Linear Gradient, namun pada

Radial Gradient digunakan untuk membuat seakan-akan seperti

bentuk bola.

Pengaturan warna dengan mengatur segitiga pada daerah

pewarna. Pada keadaan normal, segitiga di bagian kiri akan

mewakili warna di bagian tengah, sedang segitiga yang ada

dibagian kanan akan mewakili warna di bagian luar. Jika

ditambahkan segitiga lagi dengan cara klik ganda diantara

segitiga, maka hasilnya juga akan di antara dua warna

sebelumnya.

Gambar 52. pengaturan warna Radial Gradient

o Obyek Button (tombol )

Objek Button merupakan objek yang dapat diperlakukan

sebagai suatu tombol sehingga dapat memiliki keadaan-keadaan

seperti gambar berikut.
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Gambar 53. Keadaan pada sebuah tombol

ü Up State

Keadaan normal, saat objek tombol tidak dikenai suatu aksi

tertentu.

ü Over State

Keadaan ketika mouse melewati atau berada pada objek

tombol.

ü Down State

Keadaan ketika tombol kiri mouse ditekan atau klik kiri

mouse pada objek tombol.

ü Hit State

Merupakan bentuk objek yang dijadikan objek Tombol.

Bentuk ini tidak dapat terlihat dalam keadaan biasa, namun

dapat terlihat jika bagian ini dipilih di Outline Panel.

Ada dua cara untuk dapat membuat sebuah tombol, yakni

dengan menggunakan;

ü Insert Button

Dapat digunakan untuk membuat sebuah tombol baru.

Membuat tombol baru dapat dilakukan dengan;

• Klik icon Insert Button       dari Insert Toolbar, atau

• Memilih dari menu Insert >       Button.

ü Convert to button

Masuklah dari menu Modify > Convert>      Convert to

Button. Objek disini sebelumnya bukan merupakan sebuah
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tombol. Objek yang diubah menjadi tombol merupakan

objek shape.

Sebuah objek tombol dapat diatur dari Button Panel, seperti

gambar.

Gambar 54. Jendela Button Panel

• Name

Digunakan untuk memberi nama tombol di Outline Panel.

• Target

Jika diset dengan memberi tanda centang, maka dapat

diperlakukan sebagai script objek. Pilihan target dapat

digunakan jika objek diberi nama.

• Track as menu

Tombol bergerak saat mouse bergerak disekitar objek

tombol. Gaya pada objek tombol saat mouse bergerak

disekitar tombol ada dua, yakni;

ü As a push button

Track pada tombol dan ketika scane atau sprite di

jalankan, tombol dapat di klik. Pergerakan mouse

diarahkan pada objek tombol sampai tombol mouse

dilepaskan. Proses ini disebut “capturing mouse” atau
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merekam pergerakan mouse. Sebagai contoh, jika  kita

klik tombol kemudian kita drag ke luar dari objek, tombol

akan diperlakukan sebagai kondisi Over State dan krusor

mouse akan berbentuk tangan.

ü as a menu

Pada kondisi ini, ketika kita klik tombol dengan tombol

mouse, pergerakan mouse akan direkam. Sebagai contoh

misalnya jika kita klik tombol dan kita drag ke luar dari

objek tombol, tombol akan diperlakukan sebagai kondisi

Up State dan krusor mouse akan berbentuk tangan.

• Has separated over state

Jika menambah tombol over state di Outline Panel. Tombol

over state dapat diatur untuk dimodifikasi agar saat over

state nampak. Sebagai contoh, saat versi warna berbeda

dengan objek tombol ini akan nampak saat tombol dilewati

mouse.

• Has separated down state

Ketika menambahkan tombol over state di Outline Panel.

Dapat melakukan pengaturan memodifikasi tombol saat

Down State sesuai dengan keinginan, saat mouse mengklik

tombol. Sebagai contoh saat warna berbeda dengan warna

pada tombol, ini akan nampak ketika tombol dipilih.

• Has separated hit state

Ketika memilih menambah tombol over hit di Outline Panel.

Dapat dilakukan pengaturan dan memodifikasi jarak

jangkauan tombol hit state saat dipilih. Sebagai contoh saat

warna berbeda dengan warna pada tombol, saat digunakan
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tombol hit state sehingga ketika diklik maka tombol akan

bergerak sesuai dengan modifikasi.

o Objek Sprite

Objek Sprite merupakan objek yang memiliki Timeline sendiri.

Objek Sprite juga memiliki frame-frame sendiri untuk mengatur

efek-efeknya. Dapat dikatakan bahwa objek sprite merupakan

scane didalam scane.

Untuk membuat obyek sprite digunakan beberapa cara sebagai

berikut;

• Insert Sprite

Dengan memilih ini, anda akan membuat sprit baru. Untuk

membuat Sprit baru bisa melalui dua cara, yaitu;

Ø Klik icon Insert Sprite        dari Insert Toolbar, atau

Ø Memilih dari menu Insert >       Sprite.

• Convert to Sprite

Pilihan ini digunakan untuk mengubah suatu objek yang

bukan sprite menjadi objek sprite. Caranya yaitu dengan

memilih menu Modify > Convert >      Sprite  .

• Group as Sprite

Fasilitas ini digunakan untuk mengelompokkan beberapa

objek menjadi sebuah Sprite baru. Termasuk objek Sprite

yang dimasukkan dan dikelompokkan di dalam objek Sprite

yang baru.

• Import dari suatu file animasi GIF atau File SWF

Masuklah ke menu File > Import untuk dapat mengimport

file-file yang diinginkan. Jika digunakan sebagai Spite,

pilihlah jenis-jenis file animasi, yakni;
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Ø Format gambar GIF beranimasi (*.GIF), ini berbeda

dengan GIF statis yang hanya memiliki satu buah gambar

didalamnya. Untuk gambar GIF animasi memiliki lebih

dari satu gambar di dalamnya sehingga gambar-gambar

tersebut seolah bergerak.

Ø Format animasi Flash (*.SWF), yang merupakan format

file Flash.

Ø Flash Projector (*.EXE), yang merupakan format Flash

yang sudah dijadikan file executable.

Gambar 55. Jendela Import Frames

Memilih frame yang ingin dipakai dengan menggunakan

tombol Ctrl untuk pemilihan frame yang tidak berurutan atau

tombol Shift untuk pemilihan frame yang berurutan.

Keterangan dari gambar Jendela Import Frames:

• Show File Information

Menampilkan information dari file yang diimport.

Information ini meliputi besarnya ukuran file, ukuran

movie, frame rate, banyaknya frame yang digunakan,

bagian-bagian yang bisa diimport, dan bagian-bagian

yang tidak bisa diimport.
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Gambar 56. Jendela Show File Information

• Select All Frame

Fasilitas ini digunakan untuk memilih semua frame. Jika

pilihan ini tidak digunakan maka tidak bisa menggunakan

tombol Ctrl maupun Shift.

• Import Script

Fasilitas ini digunakan untuk mengimport script pada file

animasi.

• Import Background

Digunakan untuk mengimport gambar sebagai

background pada file animasi. Secara default, pilihan ini

non aktif.

• Import as Sprite

Fasilitas ini digunakan untuk mengimport gambar sebagai

Sprite tersendiri. Secara defalut ini harus aktif. Jika tidak

aktif, maka objek-objek yang akan diimport sebagai satu

buah objek Group yang berisi objek-objek di dalam file

animasi.
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• Masked

Fasilitas ini digunakan untuk background yang akan

digunakan sebagai mask jika pilihan diaktifkan.

Memasuki suatu objek Sprite atau Instance, klik pada tanda

---- di samping nama Sprite atau Instance pada Outline

Panel sampai muncul tanda      , sehingga akan masuk ke

dalam Sprite. Jika tanda Plus tidak ada, ini berarti belum ada

objek pada Sprite atau Instance.

                   Gambar 57. Kondisi awal scane

Gambar 58. Kondisi sedang diedit

o Objek Instance

Objek Instance adalah suatu objek yang merupakan clonning

dari sebuah objek Sprite. Untuk dapat membuat objek Instance

dari suatu, maka objek Sprite harus mempunyai nama.

Pengaturan objek Instance bisa dilihat pada pengaturan objek

Sprite.

Untuk membuat suatu objek Instance, ada dua cara yang dapat

dilakukan, yaitu;
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ü Membuat instance baru.

     Masuklah ke menu Insert >      Instance.  Dengan cara

seperti ini,  akan muncul jendela Insert Instance.

Gambar 59. Jendela Insert Instance

ü (b) Membuat Instance langsung dari Sprite yang diinginkan.

Pilih salah satu cara berikut untuk membuatnya;

• Pilihlah Objek Sprite yang ingin di-Clonning dari bidang

kerja. Pilih Menu Edit >      Make Instance.

• Klik kanan pada Sprite yang ingin di-Clonning pada

Outline. Pilihlah Make Instance dari menu pop up muncul.

Complex  Object

Complex Object merupakan objek yang memiliki komponen-komponen

di dalamnya, ini berbeda dengan Simple objek yang tidak memiliki

komponen-komponen di dalamnya. Complex Object ini lebih baik

dalam membuat efek-efek khusus, sebab ada beberapa efek yang

digunakan untuk Complex Object dan animasi yang dilakukan per

komponen pada objek. Ada dua macam Complex Object, yaitu;

o Objek Text

Objek ini merupakan objek yang berupa tulisan, kata-kata atau

kalimat. Pada objek text, setiap huruf termasuk spasi merupakan

sebuah komponen.

Ada dua cara untuk membuat objek text, yaitu dengan;

Insert text
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Prosedur Insert text ada dua macam, yakni;

Ø Klik icon Insert Text        dari Toolbar, atau

Ø Memilih dari menu Insert >       Text

o Import dari file teks

Prosedur Insert Text dengan menggunakan fasilitas Import, yakni

dengan;

ü Masuklah ke menu File > Import....

Kemudian akan tampil jendela Open. Pilihlah file teks

kemudian tekan Open.

ü Copy file text dari Microsoft Word dan paste di bidang kerja.

Pengaturan objek Text dapat dilakukan di Text panel.

Gambar 60. Jendela Text Panel

Keterangan dari jendela Text panel :

o Name

Digunakan untuk memberi nama text yang tampil pada Outline

Panel. Jika tidak diberi nama, maka text yang ditulis akan tampil di

Outline Panel.
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o Target

Jika di beri tanda centang, maka obyek dapat digunakan sebagai

script Object. Pilihan Target hanya ditampilkan jika obyek berisi

nama.

o Jenis dan ukuran huruf

Jenis dan ukuran font dapat diatur dari kotak drop down Font

Selector                     dan Font Size     . Jenis dan ukuran font

tergantung dari pada font-font yang ada di komputer.

o Warna

Warna digunakan untuk memberi warna pada font dengan

mengatur pada Font Color       , klik kiri pada tanda panah di Font

Color dan pilih warna yang diinginkan.

o Text type selection

Pemilihan Jenis Teks  Object Teks dapat digambarkan  sebagai

salah satu dari tiga jenis:

ü Static

Suatu obyek teks standard.

ü Dinamic

Suatu text objek dapat diubah dengan scrip ketika movie

sedang berjalan atau saat play.

ü Input

Suatu text objek dapat diubah dengan Movie Viewer, dengan

menggunakan tipe format masukan.
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o Hide Options/Dimensions/Formatting/Advanced

Pilihan yang ada di text option antara lain:

• Hide Options

Menyembunyikan dimensi, format dan pengeturan text lebih

lanjut.

Gambar 61. Hide Options

• Dimensions

Menampilkan option control untuk pengontrolan text, seperti;

(a) Enable Margins and Indent

Pilihan ini digunakan untuk mengatur margin dan ident di

objek text. Ketika dipilih maka pengaturan yang  dapat

dilakukan sebagai berikut;

Ø Indent

Menetapkan jumlah untuk memberi spasi garis yang

pertama Obyek Teks.

Ø Width

Menetapkan ukuran garis tepi yang benar untuk Obyek

Teks.

Auto-Size Height
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Ketika dipilih tinggi bidang text sebagai ukuran text. Jika

didak dapat dilakukan, maka dapat menggunakan

fasilitas;

Height/Lines

Ketika fasilitas ini dipilih, maka dapat menggambarkan

tingginya bidang teks untuk di-set dalam ukuran pixels.

Ketika garis ini dipilih, dapat menggambarkan tingginya

bidang teks untuk pengaturan tebal garis.

Gambar 62. Dimentions

(b) Formatting

Pilihan yang ada pada Formatting option sebagai berikut;

§ Auto kerling

Ketika menggunakan fasilitas ini, digunakan pengaturan

kerling Setting.

§ Render text as HTML

Format option untuk Text  HTLM, seperti ukuran dan

hyperlinks untuk masukan dan bidang teks dinamis.

HTML teks pengaturan hanya dapat dilihat secara

eksternal dari SWISHMAX.

§ Wrap Text at Word Breaks

Garis tepi pada text pada keseluruhan bidang text.

§ Kerling
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Kerling dapat digunakan untuk mengatur jarak horisontal

antar huruf-huruf pada teks. Nilai negatif membuat jarak

antar huruf semakin mendekat. Sedang sebaliknya untuk

nilai  positif akan membuat jarak antar huruf semakin

menjauh. Suatu nilai nol atau default tidak membuat

perubahan.

§ Leading

Leading digunakan untuk mengatur vertikal antar baris-

baris pada teks. Untuk nilai negatif, membuat jarak antar

baris semakin mendekat. Sedang nilai positif, membuat

jarak antar baris semakin menjauh. Suatu nilai nol atau

default tidak membuat perubahan.

Gambar 63. Formatting

(c) Advenced

Pilihan yang ada pada Advenced option sebagai berikut;

§ Black Border with White Background

Menunjukkan bidang teks dengan suatu perbatasan

hitam dan suatu backgroud putih.

§ Text is Selectable

Dapat digunakan untuk  memilih teks di dalam bidang

teks.
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§ Password Text

Karakter ditampilkan untuk masing-masing karakter teks,

yang bermanfaat untuk kata sandi masuk bidang.

§ Multiline Text

Pengguna harus menggunakan memasukan kunci untuk

newlines ketika memasuki teks di dalam suatu bidang

teks masukan.

§ Use Parent Name as Text

Menggunakan nama parent group/ scane/ Button/ sprite

sebagai teks. Menggunakan teks di button states ketika

teks nampak di tombol dengan nama yang sama.

Gambar 64. Advanced

o Text Flow

Aliran teks dapat diatur dengan menggunakan kotak drop down

Text Flow, icon diklik maka akan mucul empat buah icon, yakni;

 mengatur dari kiri kekanan, dari atas ke bawah

Ini digunakan untuk default seting

 mengatur dari atas ke bawah, dan dari kanan ke kiri

 mengatur dari kanan ke kiri, dan dari atas ke bawah

mengatur dari atas ke bawah, dan dari kiri ke kanan
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Selain itu juga bisa melalui, menu Modify > Appereance,

kemudian pilih aliran yang diinginkan.

Gambar 65. Jendela Text Flow

o Bold

Untuk membuat teks menjadi tebal, ada beberapa cara yang dapat

dilakukan, yakni;

Ø Aktifkan icon Bold       pada Text Panel.

Ø Masuklah ke menu Modify > Appereance >          Bold .

Ø Gunakan kombinasi tombol Ctrl+B.

o Italic

Untuk membuat teks miring, cara yang dapat dilakukan sebagai

berikut;

Ø Aktifkan icon Italic       pada Text Panel.

Ø Masuklah ke menu Modify > Appereance >        Italic .

Ø Gunakan kombinasi tombol Ctrl+I.

o Perataan text

Penataan teks digunakan untuk mengetur perataan pada teks.

Peraturan ini akan lebih jelas terlihat jika dalam satu paragraf.

Macam-macam pilihan perataan teks, yaitu;
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Ø Align Left       untuk mengtur teks rata kiri.

Ø Centrer       untuk mengatur teks rata tengah.

Ø Align Right       untuk mengetur teks rata kanan.

Ø Full       untuk mengetur teks rata kiri dan rata kanan.

o Objek Group

Komponen-komponen yang ada pada objek Group bukanlah

huruf-huruf, namun merupakan komponen-komponen yang

dipilih sendiri. Sehingga yang ada membuat group dari objek-

objek yang sudah ada sebelumnya.

Untuk membuat objek Group bisa menggunakan Group as

Group dengan  cara sebagai berikut;

ü Masuklah ke menu Modify > Grouping > Group as

Group, atau

ü Klik kanan pada objek pilih Grouping > Group as Group.

Gambar 66. Jendela Modify Grouping

3)  Timeline

Timeline merupakan tempat dimana frame-frame yang menyusun

suatu efek. Timeline sangat penting untuk menentukan animasi yang

akan dipakai dan pada waktu tertentu.
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Gambar 67. Jendela Timeline

• Add Effect

Fasilitas  ini digunakan untuk memberi efek pada objek. Sehingga

animasi dapat dibuat pada objek tersebut.

• Del Object

Digunakan untuk menghapus objek yang berada di Outline maupun

yang berada di Stack.

• Options

Option ini digunakan untuk mengatur ukuran yang ada pada

Frame-frame di Timeline. Pilihan yang disediakan, yakni;

ü Narrow

Membuat lebar Timeline manjadi lebih sempit.

ü Standard width

Membuat lebar Timeline menjadi standar atau normal.

ü Wide

Membuat lebar Timeline menjadi lebar.

ü Short

Membuat tinggi baris pada Timeline manjadi pendek.

ü Standard Height

Membuat tinggi Timeline menjadi standar atau normal.

ü Tall

Membuat tinggi baris pada Timeline manjadi panjang.
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ü Show Seconds

Memberi tanda hitam pada Timeline yang menunjukkan waktu

atau banyaknya frame.

• Shrink

Digunakan untuk minimize dan maximize tombol.

              (a) sebelum                                 (b) Sesudah

Gambar 68. Contoh Shrink

• Stack

Pada Stack akan terlihat scane dan objek-objek yang digunakan.

Scane selalu terletak dibagian paling atas kemudian baru objek-

objek. Komponen-komponen pada urutan bidang kerja pada

abstrak disebut dengan layer.

Gambar 69. Stack

4) Frame

Frame merupakan suatu bagian dari Timeline. Sebuah frame mewakili

suatu selang waktu yang digunakan pada Timeline. Banyaknya Frame

yang digunakan dalam satuan detik dapat diatur dengan Frame Rate

yang terdapat pada Movie Panel.
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Setiap Frame memiliki nomor Frame masing-masing yang ditunjukkan

pada Frame Ruler. Nomor dimulai dari 0 sampai tak batas. Semakin

banyak penggunaan Frame maka file yang akan dihasilkan semakin

besar dan animasi yang dihasilkan juga lama.

Frame yang terpilih akan ditandai dengan warna biru, jika

mengaktifkan Play effect       . Pada saat animasi sedang berjalan,

akan nampak kotak merah atau Play Head yang berjalan seiring

dengan animasi.

Jika ingin menyisipkan suatu frame ke Timeline, lakukan salah satu

langkah berikut;

o Menggunakan tombol shortcut F5, atau

o Klik kanan pada frame, kemudian pilih insert frame.

Jika ingin menghapus suatu frame, lakukan salah satu langkah berikut;

o Menggunakan tombol shortcut Shift+F5, atau

o Klik kanan pada frame, kemudian pilih delete frame.

5)  Efek dan Action

Efek yang ditampilkan pada Timeline Panel berwarna putih serta

menampilkan nama atau jenis dari efek. Efek bisa ditampilkan lebih

dari frame. Action hampir sama dengan efek, juga ditampilkan pada

Timeline Panel dengan simbol action yang dilakukan. Perbedaan antara

efek dengan action adalah bahwa efek digunakan pada baris objek dan

action digunakan pada baris scane.

6)  Event dan Action

Event adalah suatu keadaan, dimana jika keadaan itu dilakukan, maka

akan dilakukan suatu action. Untuk pembahasan yang lebih lanjut akan

dibahas di bab berikutnya.
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7)  Script

 Digunakan untuk menambahkan scrip pada objek yang dipilih. Dapat

dilakukan pengaturan untuk menambah Action, Event, atau Defined

Functions. Scrip ini dapat diedit di Scrip Panel.

Gambar 70. Ruang kerja ScripT

c. Rangkuman 2

1) Di dalam mempelajari animasi 2D dengan menggunakan  program

ShiWHmax perlu terlebih dahulu mengenal bidang kerja yang

disediakan, sehingga lebih memudahkan dalam pembuatan

animasi. Bidang kerja yang ada terdiri atas menu, toolbar,toolbox,

penel-panel, dan status bar.

2) Elemen-elemen pada SWiSHmax merupakan komponen-komponen

yang digunakan untuk membuat suatu animasi. Sehingga terbentuk

suatu animasi yang pergerakannya halus tanpa patah-patah.
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d. Tugas 2

 Lakukan pengamatan terhadap tampilan pada program SWiSHmax,

perhatikan dan amati fungsi-fungsi dari setiap bagian yang ada.

Bandingkan data yang didapat dengan teori yang ada.

e. Tes Formatif 2

1) Buatlah file baru dalam SWiSHmax di komputer?

2) Lakukan penyimpan file ke dalam memori pada hardisk di

komputer.

f. Kunci Jawaban Formatif 2

1) Membuat file baru di dalam SWiSHmax sebagai berikut;

a) Masuk pada menu bar File > New,

Seperti pada gambar;

b) Dengan menggunakan kombinasi tombol Ctrl + N pada

keyboard,

c) Klik kiri pada standart tool bar,

Seperti pada gambar;
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                Klik saja

2) Menyimpan file dalam SWiSHmax sebagai berikut;

a) Masuk pada menu bar File > Save as atau save,

Seperti pada gambar;

Baik Save as atau Save hampir sama, bedanya kalau

menggunakan Save as maka penyimpanan file baru, sedang

kalau menggunakan Save file sudah tidak baru lagi atau file

sudah pernah di simpan.
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b) Dengan menggunakan kombinasi tombol Ctrl + S pada

keyboard.

g. Lembar Kerja 2

Tujuan

     Peserta diklat mampu mengubah  jenis format file yang sudah dibuat

ke format yang lain.

Alat dan Bahan

     Seperangkat komputer dengan spesifikasi kebutuhan hardware

minimum sebagai berikut;

• Windows 95/98/ME/NT4/2000/Xp

• Pentium II

• 64 Mb RAM

• Monitor 800X600 pixel dengan 256 warna

 Langkah Kerja

    Lakukan langkah-langkah seperti berikut ini;

1) Masuk pada menu bar File > Export, pilih format yang diinginkan

kemudian klik kiri mouse. Setelah itu akan tampil jendela

penyimpanan, beri nama file tersebut setelah itu klik save.

Seperti pada gambar sbb.
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2) Dengan menggunakan kombinasi tombol sebagai berikut;

a) Ctrl + E : untuk format SWf,

b) Ctrl + P : untuk format SWF + Html,

c) Ctrl + M : untuk format AVi

d) Ctrl + H : untuk format Clipboard

e) Setelah itu akan tampil jendela penyimpanan seperti diatas,

beri nama file kemudian klik Save.

 GAMBAR KERJA

 Bidang kerja SWiSHmax, sebagai berikut;
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3.  Kegiatan Belajar 3: Membuat Animasi 2 Dimensi (2D)

a. Tujuan Kegiatan Pembelajaran 3

1) Peserta diklat mampu dalam menggunakan berbagai macam efek

animasi dalam SWiShmax.

2) Peserta diklat mampu menggambar grafik berbentuk vektor dalam

SWiSHmax.

3) Peserta diklat mengetahui dan paham dalam penggunaan event

dan action yang ada dalam SWiSHmax.

b. Uraian Materi 3

1) Menggambar dan menulis dengan SWISHmax

Menggunakan fasilitas yang ada pada Toolbox, sangat cocok sekali

untuk menggambar pada bidang kerja SWiSHmax. Tollbox ini terletak

disebelah kiri Layout Panel dari bidang kerja SWiSHmax.

a) Toolbox

Untuk menggambar dengan SWiSHmax, digunakan  perangkat

Toolbox. Isi Toolbox sebagai berikut:

Gambar 71.  Perangkat Toolbox
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• Select

    Memilih objek

Digunakan untuk memilih, memindahkan, dan mengubah ukuran dari

suatu objek. Untuk memilih objek, cukup dengan klik pada objek.

Objek yang telah dipilih akan terdapat  delapan buah pegangan

disekitarnya.

                                               (a) Pemilihan sebuah objek

             (b) Pemilihan banyak objek

             Gambar 72.  Pemilihan Objek

Untuk pemilihan banyak objek, dapat dilakukan dengan menekan

tombol Shift atau Ctrl sambil memilih objek-objek yang diinginkan.

Sedang untuk menghilangkannya dengan Menekan tombol Shift atau

Ctrl kemudian pilih objek yang akan dihilangkan.

    Memindahkan objek

Untuk memindahkan objek, dengan memilih objek yang diinginkan

kemudian menekan dan menahan tombol  kiri mouse lalu dipindahkan

sambil tetap menekan tombol kiri mouse. Setelah dipindahkan

lepaskan. Harus diingat untuk memindahkan krusor mouse harus

berada di daerah objek jangan di tepi objek.
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Gambar 73. Memindahkan objek

    Mengubah objek

Untuk mengubah bentuk dan ukuran objek, dengan memilih satu dari

delapan buah pegangan yang ada pada objek. Geserlah pegangan

tersebut yang ada pada objek. Jika ingin bentuknya tidak berubah tapi

hanya mengubah ukurannya, tahanlah tombol Shift ketika menggeser

mouse.

Gambar 74.  Mengubah bentuk dan ukuran objek

• Reshape

Memindahkan objek

Cara ini seperti pada Select, dengan memilih objek kemudian tekan

tombol kiri mouse dan tahan kemudian pindahkan. Setelah itu

lepaskan lagi, maka objek akan pindah ke tempat yang diinginkan.

Mengubah bentuk objek

Untuk mengubah objek, disediakan beberapa pilihan antara lain

sebagai berikut;
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o Linear

Pada linear, selain terdapat delapan buah pegangan disetiap sudut

terdapat pegangan juga. Untuk sebuah persegi panjang terdapat

empat buah pegangan yang digunakan untuk mengubah bentuk

dalam satu sisi saja.

Gambar 75. Contoh Linear

o Quadratic

Digunakan untuk menambah sebuah pegangan diantara satu sisi

garis lurus. Sehingga garis tersebut dapat digunakan untuk

membuat gambar sesuai dengan keinginan. Pilih pegangan tersebut

kemudian tekan dan tahan tombol kiri pada mouse lalu gerakkan

sesuai dengan bentuk yang diinginkan.

Gambar 76. Contoh Quadratic

o Cubic

Digunakan untuk menambah dua buah pegangan diantara satu sisi

garis lurus. Sehingga garis tersebut dapat digunakan untuk

membuat gambar sesuai dengan keinginan. Pilih pegangan tersebut

kemudian tekan dan tahan tombol kiri pada mouse lalu gerakkan

sesuai dengan bentuk yang diinginkan.
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Gambar 77. Contoh Cubic

o Insert Vertec

Digunakan untuk menambah sebuah pegangan dimana krusor

tersebut di klik. Sehingga garis tersebut dapat digunakan untuk

membuat gambar sesuai dengan keinginan. Tapi selalu membentuk

gambar dengan bentuk sudut. Pilih pegangan tersebut kemudian

tekan dan tahan tombol kiri pada mouse lalu gerakkan sesuai

dengan bentuk yang diinginkan.

Gambar 78. Contoh Insert Vertec

o Slice

Digunakan untuk memotong objek. Dengan cara Klik kanan tombol

mouse pada sisi tepi objek, kemudian pilin cubic. Setelah akan

nampak garis yang mengikuti krusor, tempatkan krusor di tepi sisi

lain objek kemudian klik kanan dan pilih cubic. Setelah objek akan

terpotong.

                  (a) sebelum                       (b) sesudah

Gambar 79. Contoh Cubic
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• Fill Tranform

Untuk mengubah gradien pada objek gambar tanpa memindah objek.

Ø Memindah  gambar.

o Pilih Fill Tranform pada Toolbox

o Pilih objek yang akan di ubah.

o Ditengah gambar akan terdapat tanda, tekan dan tahan dengan

tombol kiri pada mouse.

o Pindahkan atau geser ke arah lain.

Gambar 80. Contoh Memindah Gambar dengan Fill Tranform

Ø Memiringkan  gambar

o Pastikan pilih Fill Tranform.

o Pilih Objek yang akan diubah.

o Pilih rotate pada tool option

o Putar gambar dengan menekan dan menahan tombol kiri pada

mouse.

Gambar 81. Contoh Memutar dengan Fill Tranform
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Ø Mengecilkan  gambar

o Pastikan pilih Fill Tranform.

o Pilih Objek yang akan diubah.

o Pada tepi gambar terdapat empat pegangan, dari sudut gambar

dengan menekan dan menahan tombol kiri pada mouse.

Gambar 82. Contoh Mengecilkan dengan Fill Tranform

• Motion Part

Menggambar alur gerakan pada objek.

o Pilih Motion Part.

o Pilih objek yang diinginkan.

o Geser objek dengan menekan dan menahan tombol kiri mouse ke

tempat yang diinginkan kemudian lepaskan.

o Ulangi lagi untuk tempat tujuan yang lain.

Gambar 83. Contoh dengan Motion Part

• Line

Digunakan untuk menggambar garis.

o Posisikan krusor mouse ke bidang yang diinginkan.
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o Tekan dan tahan tombol kiri mouse.

o Gerakkan mouse sehingga membentuk garis, kemudian lepaskan.

o Ulangi lagi step ketiga untuk membuat garis yang baru.

Gambar 84.  Contoh menggambar garis dengan Line

• Pencil

Menggambar garis dengan tangan

o Posisikan krusor mouse ke bidang yang diinginkan.

o Tekan dan tahan tombol kiri mouse.

o Gerakkan mouse sehingga membentuk gambar yang diinginkan,

kemudian lepaskan.

Gambar 85. Contoh menggambar garis sendiri

• Bezier

Ø Menggambar kurva

o Posisikan krusor mouse ke bidang untuk memulai.

o Tekan tombol kiri mouse untuk menempatkan kurva.

o Gerakkan mouse untuk membentuk kurva.

o Tekan tombol kiri mouse untuk membentuk lagi.
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o Untuk mengakhiri pembuatan kurva, ujung ditemukan dengan

pangkal.

o Kemudian tekan tombol kiri mouse.

Gambar 86. Contoh menggambar kurva

Ø Menggambar segmen garis yang dihubungkan

o Posisikan krusor mouse ke bidang untuk memulai.

o Tekan tombol kiri mouse untuk menempatkan kurva.

o Kemudian geser mouse lalu tekan tombol kiri mouse.

o Ulangi lagi step ketiga untuk membuat bentuk lain.

o Klik ganda tombol kiri mouse untuk mengakhiri.

Gambar 87. Contoh menggambar garis dengan Bezier

• Text

Digunakan untuk membuat objek bentuk teks.

o Pilih Text Tool.

o Posisikan krusor mouse untuk memulai.

o Tekan tombol kiri mouse.

o Teks akan dimasukkan ke dalam movie.

o Atur bentuk ukuran, jenis font, dan warna dengan Text Panel.



89

Gambar 88. Contoh menulis teks

• Ellipse/ circle

Digunakan untuk menggambar bentuk ellips/ Lingkaran.

o Tekan tombol kiri mouse untuk memulai membuat ellip/ lingkaran.

o Jangan lepaskan mouse, kemudian geser untuk menggambar ellip/

lingkaran.

o Lepaskan mouse, sehingga gambar ellip/ lingkaran terbentuk.

 Gambar 89. Contoh menggambar

  Ellip dan lingkaran

• Rectangle

Digunakan untuk menggambar objek bentuk persegi.

o Tekan tombol kiri mouse untuk memulai membuat gambar persegi.
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o Jangan lepaskan mouse, kemudian geser untuk menggambar

persegi.

o Lepaskan mouse, sehingga gambar persegi terbentuk.

Gambar 90. Contoh menggambar persegi

• Auto Shape

Digunakan untuk menggambar sejumlah bentuk gambar yang telah

disediakan. Adapun bentuk-bentuk gambar sebagai beriku;

Gambar 91. Menu dari Auto Shape

Memilih Auto Shape

Ø Tekan tombol kiri mouse dan jangan lepaskan sampai muncul menu

Auto Shape.

Ø Geser mouse ke dalam menu Auto Shape untuk memilih bentuk

yang diinginkan.

Ø Lepaskan menekan tombol mouse.

Menggambar Auto Shape

Ø Tekan tombol kiri mouse untuk memulai membuat gambar.

Ø Geser mouse untuk membuat gambar.

Ø Lepaskan menekan tombol kiri mouse.
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Round rectangle

Tekan tahan tombol kiri mouse dari sudut untuk menyesuaikan

ukuran.

Gambar 92. Menggambar Round rectangle

Heart,   Arrow,   Notched arrow,  Double arrow

Tekan tahan tombol kiri mouse dari sudut untuk menyesuaikan

bentuk.

Gambar 93. Menggambar Heart Arrow,

Notched arrow,  Double arrow

Star

o Tekan tahan tombol kiri mouse dari sudut untuk membuat

gambar bintang.

o Klik kanan pada tengah objek untuk mengurangi banyaknya sisi,

dan klik kiri pada tengah objek untuk memperbanyak sisi.

Gambar 94. Menggambar Bintang



92

Polygon

o Tekan tahan tombol kiri mouse dari sudut untuk membuat

gambar poligon atau segi lima.

o Klik kanan pada tengah objek untuk mengurangi banyaknya sisi,

dan klik kiri pada tengah objek untuk memperbanyak sisi.

Gambar 95. Menggambar Poligon

Cube

o Tekan tahan tombol kiri mouse dari sudut untuk membuat

penyesuaian kontras gelap terang pada gambar.

o Pada objek akan nampak warna hijau, ubah-ubah posisinya

tidak di sudut untuk menentukan kontran objek. Posisi di sudut

untuk merubah bentuk.

Gambar 96. Menggambar kubus

Beveled button

o Tekan tahan tombol kiri mouse dari sudut untuk membuat

penyesuaian kontras gelap terang pada gambar.

o Warna hijau posisinya disudut untuk penyesuaian lebar.

o Tekan dan tahan tombol kiri mouse pada warna hijau yang

posisinya di salah satu sisi untuk mengatur gelap terang objek.
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Gambar 97. Menggambar Beveled button

Rounded button

o Tekan tahan tombol kiri mouse dari sudut untuk membuat

penyesuaian kontras gelap terang pada gambar.

o Warna hijau posisinya disudut untuk penyesuaian sudut yang

dibulatkan.

o Tekan dan tahan tombol kiri mouse pada warna hijau yang

posisinya di salah satu sisi untuk mengatur gelap terang objek.

Gambar 98. Menggambar Rounded button

• Pan

Digunakan untuk memindah bidang kerja SWiSHmax di Layout Panel.

Caranya sebagai berikut;

Ø Tekan dan tahan tombol kiri mouse pada bidang kerja SWiSHmax.

Ø Geser bidang kerja tersebut.

Ø Lepaskan tombol kiri mouse.

• Zoom

Digunakan untuk memperbesar dan memperkecil bidang kerja

SWiSHmax. Untuk memperbesar dilakukan dengan menekan tombol

kiri mouse, sedang untuk memperkecil dilakukan dengan menekan

tombol Shift+ menekan tombol kiri mouse.
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b) Tool Options

Selain Toolbox, ada Tool Options yang digunakan untuk memodifikasi

gambar sesuai dengan keinginan.

Gambar 99. Perangkat Tool Options

• Scale

Membuat skala objek

o Tekan tombol kiri mouse pada objek yang akan diubah skalanya.

o Tekan dan tahan tombol kiri mouse pada objek kemudian geser

sehingga objek lebih besar atau lebih kecil.

                                (a) sebelum (b) sesudah

Gambar 100. Membuat Scale objek

• Resize

o Tekan tombol kiri mouse pada objek yang akan diubah ukurannya.

o Tekan dan tahan tombol kiri mouse pada objek kemudian geser

untuk membuat posisi baru kemudian lepaskan.

Gambar 101. Menggambar Resize objek
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• Rotate/skew

Ø Memutar objek

o Tekan tombol kiri mouse pada objek yang akan diubah

rotasinya.

o Tekan dan tahan tombol kiri mouse pada objek kemudian geser

untuk membuat sudut baru kemudian lepaskan.

Gambar 102.  Rotare/ skew objek

Ø Memutar objek di KeyFrame

o Pilih objek.

o Klik di di Timeline Ruler untuk memasukkan Preview Frame

mode.

o Klik pada pegangan di tengah objek, kemudian geser.

o Sedang untuk pegangan yang ada ditepi digunakan untuk

memutar objek.

Gambar 103.  Rotare/ skew objek di Key Frame

• Perspective

Digunakan untuk memodifikasi perspektif objek.

o Tekan tombol kiri mouse untuk memegang suatu perspektif.

o Tekan dan tahan tombol kiri mouse pada salah satu sisi pada objek

kemudian geser untuk membuat posisi baru kemudian lepaskan.
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Gambar 104.  Memodifikasi perspektif objek

• Speed

Kecepatan digambarkan sebagai tingkatan pergerakan yang digunakan

oleh Motion Part. Meningkatkan pixel per detik akan mengurangi

banyaknya frame digunakan, ketika menurunkan nilai akan

meningkatkan nomor dari frame yang digunakan.

c) Tool View

Digunakan untuk mengubah tampilan pada bidang kerja SwiSHmax.

Gambar 105. Perangkat Tool View

• Zoom Factor

Digunakan untuk mengatur tampilan dalam %. Faktor tampilan yang

dapat dipilih adalah 25%, 33%, 50%, 66%, 75%, 100%, 150%,

200%, 300%, 400%, 500% dari ukuran sebenarnya.

• Fit Scane in Widow

Digunakan untuk mengatur tampilan pada bidang kerja agar tepat

sesuai dengan besarnya scane yang aktif saat itu.
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• Zoom 100%

Digunakan untuk menampilkan bidang kerja dengan ukuran yang

sebenarnya.

• Zoom in

Digunakan untuk memperbesar tampilan pada bidang kerja sebesar

1,5 kali dari ukuran semula.

• Zoom Out

Digunakan untuk memperkecil tampilan pada bidang kerja sehingga

menjadi 2/3 kali ukuran semula.

• Show/hiden grids

Digunakan untuk menampilkan atau menghilangkan bentuk kotak-

kotak pada bidang kerja. Pada default seting, dibuat tidak ada grid

atau tampilan kotak-kotak yang memenuhi bidang kerja sehingga

nampak membagi bidang kerja menjadi kotak-kotak.

• Snap to Grid

Ini terletak disekitar garis kotak-kotak (grad line). Digunakan untuk

membantu dalam konsistensi ukuran, posisi dan tempat suatu objek.

d) Membuat efek dengan SwiSHmax

o Place Effects (Efek tempat)

Merupakan effek sederhana yang digunakan untuk menambahkan,

memindahkan, dan pindah suatu objek di dalam movie. Pilihan yang

disediakan sebagai berikut;

Place

Efek tempat menampilkan objek. Efek ini panjangnya satu frame dan

ditandai frame dalam Timeline. Digunakan efek tempat untuk

memindahkan objek kemudian menampilkannya.

Dapat dilakukan dengan salah satu cara berukut;



98

o Pilih objek, kemudian klik kanan effect > Place, atau

o Klik kiri pada Timeline Ruler, kemudian klik kanan lalu pilih Place,

atau

o Dari Timeline pilih Add Effect > Place.

Remove

Digunakan untuk memindahkan efek yang telah ditampilkan dalam

movie. Efek ini panjangnya satu frame yang terdapat di Timeline ruler.

Move

Efek move digunakan untuk mengubah kondisi suatu objek, yaitu

memindahkan letak atau posisi, mengubah ukuran, sudut, transparansi

dan warna dari suatu objek. Pada efek move ini, dapat digunakan lebih

dari satu frame.

o Basic Effects (efek dasar)

Efek dasar yang disediakan sebagai berikut;

Fade In

Menampilkan objek yang perlahan-lahan muncul. Fade in seting hanya

memiliki dua buah tab, yaitu Motion dan Easing. Berikut contoh, terdiri

dari tiga fame.

Gambar 106. Efek Fade in

Fade Out

Merupakan kebalikan dari Fade in, yakni digunakan untuk membuat

objek perlahan-lahan menghilang. Fade Out seting hanya memiliki dua

buah tab, yaitu Motion dan Easing.
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Gambar 107. Efek Fade out

Zoom in

Digunakan untuk memperbesar objek, objek mulai dari kecil dan

berlahan-lahan membesar.

Gambar 108. Efek Zoom in

Zoom out

Digunakan untuk memperkecil objek. Ini merupakan kebalikan dari

Zoom in. objek mulai dari besar dan berlahan-lahan mengecil.

Gambar 109. Efek Zoom out

Slide in

Digunakan untuk membuat objek bergerak dari luar menuju bidang

kerja di tepat yang telah ditentukan. Pilihan yang sudah disediakan

sebagai beriku;

• In from left

Objek akan muncul dari arah kiri luar bidang kerja.

• In from right

Objek akan muncul dari arah kanan luar bidang kerja.
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• In from top

Objek akan muncul dari arah atas luar bidang kerja.

• In from bottom

Objek akan muncul dari arah bawah luar bidang kerja.

• In from top left

Objek akan muncul dari arah sudut kiri atas luar bidang kerja.

• In from top right

Objek akan muncul dari arah sudut kanan atas luar bidang kerja.

• In from bottom left

Objek akan muncul dari arah sudut kiri bawah luar bidang kerja.

• In from bottom right

Objek akan muncul dari arah sudut kanan bawah luar bidang kerja.

• Out from left

Objek akan keluar ke arah kiri luar bidang kerja.

• Out from right

Objek akan keluar ke arah kanan luar bidang kerja.

• out from top

Objek akan keluar ke arah atas luar bidang kerja.

• Out from bottom

Objek akan keluar ke arah bawah luar bidang kerja.

• Out from top left

Objek akan keluar ke arah sudut kiri atas luar bidang kerja.

• Out from top right

Objek akan keluar ke arah sudut kanan atas luar bidang kerja.

• Out from bottom left

Objek akan keluar ke arah sudut kiri bawah luar bidang kerja.

• out from bottom right

Objek akan keluar ke arah sudut kanan bawah luar bidang kerja.
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Blur

Efek ini digunakan untuk menampilkan objek yang pertama-tama

kabur kemudian perlahan-lahan menjadi jelas, atau sebaliknya. Blur

seting memiliki tiga buah tab, yaitu tab blur, motion, dan easing.

Contoh perubahan sebagai berikut;

Gambar 110. Efek Blur

Repeat Frame

Digunakan untuk mengulangi penggunaan efek-efek sebelumnya.

Repeat Frame tidak memiliki tab, bisa juga dikatakan hanya memiliki

satu sehingga tidak ditampilkan.

Gambar 111. Repeat Frame Setting

o Complex Effects (efek komplek)

Merupakan efek dari gabungan beberapa efek menjadi sebuah efek.

Macam-macam efek yang komplek sebagai berikut;
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Appear into position

Efek disini merupakan kumpulan dari bermacam-macam efek, namun

efek disini efek-efek dalam jenis apprear inti position atau tampil di

bidang kerja.

Gambar 112. Jenis-jenis animasi Appear Into Pasition

Disappear from position

Efek disini merupakan kumpulan dari bermacam-macam efek, namun

efek disini efek-efek dalam jenis disappear inti position atau

meninggalkan bidang kerja.
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Gambar 113. Jenis-jenis animasi Disappear From Pasition

Looping Continuously

Efek disini merupakan kumpulan dari bermacam-macam efek. Tapi

efek ini dalam jenis efek yang looping atau berulang.
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Gambar 114. Jenis-jenis animasi Looping Continuousy

One off

Efek disini merupakan kumpulan dari bermacam-macam efek. Tapi

merupakan gabungan dari jenis efek yang menghilang atau

meninggalkan bidang kerja.

Gambar 115. Jenis-jenis animasi One Off
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Return to star

Efek disini akan mengulang seperti di looping, namun kalau efek ini

akan mengulang selalu kembali dari star lagi.

Gambar 116. Jenis-jenis animasi Retyrn To Star

o Core Effects (efek inti)

Menciptakan efek baru yang didasarkan dari efek dasar. Efek inti yang

dapat diciptakan dari efek dasar sebagai berikut;

Transform

Digunakan untuk menampilkan objek seolah-oleh berasal dari depan

layar. Efek ini lebih bagus digunakan pada Complex Object

dibandingkan digunakan pada Simple Object. Karena pada Complex

Object masing-masing objek akan menjalankan animasi sendiri-sendiri,

sedang pada Simple Object, karena hanya terdiri dari satu objek maka

animasi hanya berjalan pada satu objek itu.
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Gambar 117. Efek Transform

Squeeze

Efek ini hanya untuk Complex Object, sedang jika digunakan di dalam

Simple Object maka hasilnya tidak akan terlihat. Pergeraka efek ini

membuat Complex Object dianimasikan kiri-kanan.

Gambar 118. Efek Squeeze

Alternate

Digunakan untuk animasi zig-zag.

Gambar 119. Efek Alternate

Snake

Digunakan untuk membuat animasi seperti ular yang sedang bergerak.

Efek ini paling banyak memiliki variasi animasi.
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Gambar 120. Efek Snake

Explode

Hanya digunakan untuk objek teks maupun objek gambar. Dapat

dibuat untuk memutar, berubah ukuran, menghilang dan meledak.

Gambar 121. Efek Explode

3D Spin

Efek ini membuat komponen-komponen pada suatu Complex Object

menjadi berputar. 3D Spin seting memiliki lima buah tab, yakni tab 3D

Spin, Camera, Cascade, Motion, dan Easing.

Gambar 122. Efek 3D Spin

3D Wave

Digunakan untuk membuat efek gelombang secara 3D.
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Gambar 123. Efek 3D Wave

Vortex

Efek digunakan untuk memutar komponen-komponen pada Complex

Object dan menghisapnya ke arah tertentu, yaitu suatu titik gravitasi.

Gambar 124. Efek Vortex

Wave

Efek yang digunakan untuk membaut gelombang yang umumnya

digunkan pada teks untuk membuat suatu banner untuk membuat

iklan pada situs.

Gambar 125. Efek Wave

Typewriter
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Efek yang digunakan untuk mengetik, dengan adanya suatu krusor

seperti bentuk garis bawah (_) yang berkelap-kelip.

Gambar 126. Efek Typerwriter

e) Event dan Action

Ada tiga tipe Event, yakni;

Ø Frame

Frame Event terjadi saat movie berjalan dari frame ke frame secara

spesifik. Ada beberapa pilihan yang disediakan, yakni;

o OnFrame

 Event di-triger tepat sebelum spesifik frame ditampilkan.

o Onload

 Event di-Triger ketika Sprite atau scane pertama ditampilkan.

o OnEnterFrame

Event di-triger saat frame dimasukkan.

Gambar 127. Event Frame
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Ø Button

Event pada button atau tombol akan terjadi saat terjadi interaksi

antara mouse dengan objek. Menambah event tombol di objek untuk

membuat agar seolah-olah seperti tombol dan mau mengikuti respon

dari pergerakan mouse.

Beberapa pilihan yang disediakan sebagai berikut;

• on (press)

Tekan tombol kiri pada mouse selagi berada diatas tombol.

• on (release)

Lepaskan tombol kiri pada mouse setelah selesai.

• on (rollOver)

Gerakkan krusor mouse ke tombol tanpa menekan tombol mouse.

• on (rollOut)

Gerakkan krusor mouse dari tombol ke luar tombol tanpa menekan

tombol mouse.

• on (dragOver)

Gerakkan krusor mouse dari luar tombol dengan menekan tombol

kiri pada mouse.

• on (dragOut)

Gerakkan krusor mouse dari tombol ke luar dengan menekan

tombol kiri pada mouse.

• on (releaseOut)

Lepaskan tombol mouse yang kiri setelah menggerakkan kursor di

luar  tombol itu.

• on (keyPress)

Pilih key yang disediakan untuk masuk dalam Key Field atau pilih

dari Command Key dari menu.
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Gambar 128. Button

Ø Self

Event pada button atau tombol akan terjadi saat terjadi interaksi

antara mouse dengan objek saat ditekan. Disini lebih dari action yang

dapat ditampilkan.

Beberapa pilihan yang disediakan sebagai berikut;

• onSelfEvent (press)

Tekan tombol kiri pada mouse ketika berada di sprite.

• onSelfEvent (release)

Lepaskan tombol kiri pada mouse ketika berada di sprite.

• onSelfEvent (rollOver)

Gerakkan krusor mouse dari luar sprite ke sprite tanpa menekan

tombol mouse.

• onSelfEvent (rollOut)

Gerakkan krusor mouse dari dalam sprite keluar  sprite tanpa

menekan tombol mouse.

• onSelfEvent (dragOver)
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Gerakkan krusor mouse dari luar sprite ke sprite dengan menekan

tombol mouse.

• onSelfEvent (dragOut)

Gerakkan krusor mouse dari dalam sprite keluar  sprite dengan

menekan tombol mouse.

• onSelfEvent (releaseOut)

Lepaskan tombol mouse yang kiri setelah menggerakkan kursor di

luar  sprite itu.

• onSelfEvent (keyPress)

Kunci yang diperlukan dapat dimasukkan ke dalam Key Field Kunci

atau memilih dari kunci yang umum drop-down Menu.

Gambar 129.  onSelfEvent (keyPress)

Actian akan bekerja setelah mendapat Event. Action dapat mengubah

saat movie dimainkan, seperti star atau stop sound, Pergantian

kehalaman movie lain, atau berkomunikasi dengan pengguna. Action

akan ditampilkan di Scrip Command untuk menangani fungsi-fungsi

tertentu. Ini dapat ditampilkan dengan Scrip Panel.

Action-action yang disediakan sebagai berikut;

• Frame Actions
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Ø Set Label

Digunakan untuk membuat suatu label pada suatu frame dari

suatu scane. Label digunakan untuk mewakili nomor suatu

frame menjadi  nama sehingga mudah diingat. Action ini dapat

digunakan dengan rujukan Goto Frame atau If Frame Loaded.

                             (a)                                           (b)

Gambar 130. Set Label

Ø Preload Content

Digunakan ketika menginginkan bagian-bagian dari isi movie di

download dahulu sebelum digunakan. Kebanyakan objek

memiliki Preload Option yang diset ‘At Preload Frame’ yang akan

di download pada step ini. Preload Option terdapat pada Export

Panel objek.

Dalam satu movie bisa terdapat lebih dari satu Preload Content

Action. Obyek untuk preloaded akan Di download di frame yang

terdekat dengan Preload Content Action sebelum pertama kali

digunakan. Sebagai contoh, jika Obyek untuk yang pertama Di

download digunakan pada frame 18 dan dua download pada

frame 10 dan frame 20, Obyek akan terisi pada frame 10.

Preload Content action tidak diperlukan untuk isi. Sebagai

contoh, jika suatu bunyi belum di download dan ketika
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memainkan suara (play sound) maka suara akan secara

otomatis di download.

• Movie control Actions

Ø Play

Digunakan untuk memainkan movie atau sprite. Jika movie

dihentikan, kemudian di mainkan lagi maka akan mengulang

dari frame awal. Jika movie atau sprite sudah dimainkan,

sehingga di Play Action tidak ada efek.

Gambar 131. Play Target

Target dari movie atau sprite yang akan dimainkan.

Ø Stop

Digunakan untuk menghentikan movie atau sprite. Saat movie

atau sprite dimainkan, akan dihentikan oleh Stop Action. Jika

movie atau sprite telah dihentikan, maka tidak ada efek lagi.

Gambar 132. Stop Target

Target dari movie atau sprite yang akan dihentikan.

Ø Goto And Play

Digunakan untuk pindah ke frame yang lain. Ini bisa dalam satu

scane atau lain scane.
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Gambar 133. Stop Target

Keterangan dari Stop target:

o Target

Target dari movie atau sprite yang akan dijalankan. Ini

memungkinkan untuk memulai memainkan movie atau sprite

dari frame 10. Scane dapat juga dijadikan target, dalam hal

ini Obyek Target diasumsikan sebagai Obyek yang sekarang.

Pengaturan spesifik frame dapat dilakukan dengan cara;

Dengan nomor frame dalam scane.

Dengan frame label.

Dengan melewati beberapa frame.

o Frame

Digunakan untuk memulai movie atau sprite dijalankan.

Dengan memberi nomor frame, sehingga dari nomor

tersebut movie atau sprite mulai dimainkan.

o Label

Pilih label, kemudian pilih pada nomor frame yang

diinginkan. Frame dapat dipilih dimanapun di movie atau

sprite.

o Skip

Digunakan untuk melewati secara spesifik positif atau negatif

frame. Sebagai contoh, jika mulai 1 kemudian movie akan ke

frame selanjutnya. Ketika dimulai -1, movie akan ke frame

sebelumnya.

o Play
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Ketika dipilih play, movie atau sprite akan melanjutkan

memainkan dari spesifik frame yang tertera.

o Stop

Ketika dipilih stop, movie atau sprite akan menampilkan

frame dan kemudian berhenti.

Ø Load Movie

Digunakan untuk memanggil file SWF yang lain untuk ke Flash

Player yang sedang aktif.

Gambar 134. Load Movie

o URL

Harus dipilih file SWf yang akan dimasukkan. Jika tidak, akan

didasarkan pada URL untuk yang sekarang ini terbuka.

Ketika menjalankan suatu browser, dapat mengesampingkan

dasar URL yang menggunakan ] ' Dasar' Pilihan pada  HTML

Panel Ekspor.

o Load Info

Sprite

Digunakan untuk mengisikan file SWF ke dalam sprite

atau scane. Ini akan menggantikan isi dari sebelumnya di

sprite, akan tetapi posisi dan ukuran sprite dan beberapa

efek juga akan diganti.

Level

Digunakan untuk mengatur level dari file SWF yang akan

diisikan. Movie akan memasukan ke dalam klevel yang
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lebih tinggi yang akan tampil didepan level yang lebih

rendah.

o Variables

Dengan menerapkan metode HTTP untuk mengirim variabel

ke movie yang akan dimasukkan.

Don’t send variables, berarti tidak ada variabel yang

dikirim.

Send using Get, Berarti metode GET untuk

menambahkan variabel sampai URL, dan digunakan

untuk angka-angka variabel kecil.

Send using Post, berarti metode POST untuk mengirim

variabel didalam suatu HTTP untuk variabel string yang

panjang.

o Load Variables only

Untuk membaca variabel dari spesifik URL, baik berupa teks

atau Scrip. Isi dari Sprite atau spesifik level tidak digantikan,

hanya nilai dari variabel saja.

Ø Unload Movie

Digunakan untuk menghapus file SWF yang sebelumnya diisikan

pada suatu spesifik level.

Gambar 135. Unload Movie

Keterangan dari Unload Movie :

Ø Source
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Variabel ini untuk menentukan apakan movie harus dihapus dari

level atau sprite.

Sprite

Digunakan untuk menetapkan sprite yang akan dihapus.

Beberapa file SWF movie didalam sprite yang sudah kosong.

Level

Untuk menetapkan spesifik level yang kan dihapus, sehingga

file SWF dalam movie akan kosong.

• Conditional Actions

Ø If Frame Loaded

Digunakan untuk melaksanakan tindakan hanya frame

dimasukkan. Ini dapat bermanfaat ketika menciptakan suatu

preloader.

Gambar 136. If Frame Loaded

Keterangan dari If Frame Loaded :

• Target

Target dari movie, sprite atau objek yang akan direspon.

Target nama harus menggunakan target property.

• Frame

Pilih frame, kemudian masukkan nomor frame di dalam

Action Panel. Dapat memilih scara langsung dengan nama

atau pilihan yang telah disediakan.
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• Label

Memilih label pada frame yang diinginkan. Frame bisa

terdapat dimana-mana didlam movie atau sprite.

• Skip

Menetapkan nomor positif dan negatif pada frame untuk

melewati dan menguji saat dimasukkan.

Ø If near

Digunakan untuk melaksanakan tindakan jika sprite didekat

sprite yang lain. Dapat dilakukan pengaturan seberapa dekat

jarak antar sprite dalam arah X dan Y.

Ø If Droupped On

Digunakan untuk melaksanakan tindakan, jika sprite di drop

ooleh sprite lain saat di drag.

Gambar 137. If droupped on

Target, dari movie, sprite atau objek yang akan direspon.

Target nama harus menggunakan flash notasi atau target

property.

Ø If Chance

Digunakan untuk melaksanakan Tindakan secara acak. Dapat

menetapkan kesempatan Tindakan diambil sebagai

kemungkinan persentase.
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Gambar 138.  If Chance

Keterangan dari If Chance :

Random Chance

Digunakan untuk memilih kesempatan bahwa tindakan yang

akan dilaksanakan sebagai kemungkinan prosentase. Sebagai

contoh, sprite mempunyai suatu 25% kesempatan melompat

untuk frame 10.

Ø If

Digunakan untuk menandai saat star dari suatu alternatif  untuk

melaksanakan tidakan. Kondisi ini akan mengendalikan

tindakan.

Ø While

Digunakan untuk menandai star saat perulangan tindakan untuk

dilaksanakan saat kondisi jika kondisi mengendalikan tindakan.

Ø Do While

Digunakan untuk melaksanakan suatu set tindakan dan

kemudian mengevaluasi kondisi di dalam perulangan saat jika

kondisi mengendalikan tindakan.

Ø Else

Digunakan untuk menandai star dari suatu alternatif tindakan

untuk melaksanakan jika kondisi jika kondisi mengendalikan

tindakan.

Ø Else If
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Digunakan untuk menambahkan suatu tindakan jika tindakan

digunakan untuk mengevaluasi, jika kondisi mengendalikan

tindakan.

• Mouse dragging Actions

Ø Star Drag

Digunakan ketika ingin memulai mengedrag suatu sprite dengan

mouse. Untuk menghentikannya, gunakan Stop Drag Action.

Tindakan ini pada umumnya ditempatkan suatu Press Event.

Ø Stop Drag

Digunakan setelah melakukan drag terhadap sprite. Tindakan

Ini pada umumnya ditempatkan suatu Release Event.

• Sprite Actions

Ø Tell Terget

Digunakan untuk memanggil sprite tertentu. Sprite dalam

sebuah tombol tidak dapat sebagai target, walaupun memiliki

nama yng sama. Target dapat tersarang di dalam target yang

lain. Dalam hal ini, dibutuhkan terget yang lebih spesifik.

Ø Duplicate Sprite

Digunakan untuk menyalin sprite di dalam suatu movie.

Gambar 139. Duplicate Sprite

o Target
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 Merupakan target dari movie atau sprite yang akan di

duplikat atau di salin.

o Name

 Merupakan nama dari sprite baru yang dibuat.

o Depth

 Untuk depth yang seharusnya >= 0, Menyalin sprite dari

pada kedalaman lebih tinggi nampak di depan sprite dari

salinan pada kedalaman lebih rendah. Dapat menggantikan

suatu sprite dari salinan dengan penetapan kedalaman yang

sama sebagai sprite lain. Semua sprite dari salinan nampak

di depan semua Object statis.

Ø Remove Sprite

Digunakan ketika ingin menghapus suatu sprite yang dibuat

dengan menggunakan duplikat sprite.

Gambar 140. Remove Sprite

Target, dari movie atau sprite yang akan dihapus.

• Statements

Ø Evaluate

Digunakan untuk mengevaluasi suatu ungkapan. Ini dapat juga

digunakan untuk masuk bentuk garis tunggal tanpa harus

mengunakan pull-down prosedur. Sebagai contoh dapat

mengetik " this._X+= 5" tanpa penggunaan menugaskan

tindakan dan multi parameter.

Ø Assign
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Digunakan untuk mengubah suatu propeties dalam objek, sprite

atau movie.

Gambar 141. Assign

o Target

Merupakan target dari movie atau sprite.

o Property

Untuk memilih variabel atau property yang akan di set.

o Operator

Untuk propeties atau variabel, dapat diset suatu nilai baru

(=), menambahkan (+=) atau mengurangi (-=) suatu nilai,

atau mengalikan (*=) atau membagi (/=) dengan suatu nilai

tetap atau oleh bersesuaian nilai dari sprite lain. Dapat juga

untuk membatasi nilai property pada suatu nilai minimum

atau maksimum.

Ø Function

Digunakan untuk memanggil fungsi lain yang akan ditampilkan.

Gambar 142. Function

o Target
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 Untuk memilih movie atau sprite yang akan dipanggil.

o Function

 Fungsi yang akan dipanggil.

o Argument

      Argumentasi untuk digunakan oleh fungsi.

Ø Call

Mengikuti apa yang dipanggil dalam label frame suatu nominani

klip. Dapat menggunakan library pada Action Scrip di sprite dan

memanggil dari tempat lain.

Gambar 143. Call

o Target

Merupakan target dari movie atau sprite yang akan

dipanggil.

o Label

Digunakan untuk memilih label dalam frame yang akan

dipanggil. Frame terdapat didalam movie atau sprite.

Ø Return

Digunakan untuk mengembalikan suatu nilai dari suatu fungsi.

Gambar 144. Return
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Return, merupakan string atau ungkapan dari nilai yang akan

dikembalikan. Sebagai contoh, Jika fungsi dimaksudkan untuk

dikembalikan di area suatu lingkaran.

• Sound Actions

Ø Play Sounds

Dalam kaitan dalam pembatasan Flash Player, sounds akan

dimainkan saat merespon Frame Event, atau the Mouse Events

Press, Release, Roll Over or Roll Out. Sounds tidak dapat

dimainkan untuk merespon the Mouse Events Drag Over, Drag

Out or Release Outside.

Action yang digunakan sebagai berikut;

Gambar 145. Play sounds

o Import

Digunakan untuk mengimport suatu sound (bunyi) ke dalam

movie. Dapat mengimport Windows .Wav memfile atau .mp3

file sounds.

o Reload

Digunakan untuk menambah kan file sounds yang

sebelumnya sudah ada. Ini bermanfaat jika sounds file di

disk drive diubah sejak terakhir dimasukkan.

o Delete
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Digunakan untuk menghapus sounds di dalam movie, ini

tidak akan menghapus sounds di disk drive. Hanya

memindahkan  dari dalam . swi file tidak bisa dimainkan.

o Propeties

Menyediakan format “Content” untuk memodifikasi propertis

dari file sounds yang dimasukkan  dikompres, channel dan

sample rate.

o Sounds Effect

Digunakan untuk memodifikasi file sounds yang akan

dimainkan.

Ø Stop Sounds

Digunakan untuk menghentikan sound yang telah dipilih. Untuk

pilihan dan batasan sama dengan Play sounds Action. Akan

tetapi, sebagai ganti dari sounds yang dimainkan dihentikan.

Ø Stop All Sounds

Digunakan untuk menghentikan semua sound yang ada di

dalam movie atau sprite.

• Browser/network Actions

Ø Get URL

Digunakan untuk mengisi suatu URL ke dalam frame dalam

browser.
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Gambar 146. Get URL

o URL

Harus dipilih file SWf yang akan dimasukkan. Jika tidak, akan

didasarkan pada URL untuk yang sekarang ini terbuka.

Ketika menjalankan suatu browser, dapat mengesampingkan

dasar URL yang menggunakan  'Dasar' Pilihan pada  HTML

Panel Ekspor.

o Variables

ü Don’t send variables, berarti tidak ada variabel yang

dikirim.

ü Send using Get, Berarti metode GET untuk

menambahkan   variabel sampai URL, dan digunakan

untuk angka-angka variabel kecil.

ü Send using Post, berarti metode POST untuk mengirim

variabel didalam suatu HTTP untuk variabel string yang

panjang.

Ø Fs Command

Digunakan untuk mengirim perintah kepada browser.

Gambar 147. FS Command
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o Command

Digunakan untuk menetapkan perintah yang akan masuk.

o Argument

Digunakan untuk memberikan informasi di scrip untuk

perintah yang diberikan.

Ø Javascrip

Digunakan secara langsung untuk melaksanakan beberapa

Javascript.

Gambar 148. Javascrip

Javascript dapat mempunyai berbagai bentuk. SWISHMAX akan

secara otomatis ' lepas' yang kosong dan newlines dll. Awalan "

javascript:", dan menambahkan catatan "; void(0);" sebelum

dikirimkan  kepada browser.

Ø Mailto

Digunakan untuk mengirim E-mail.

Gambar 149. Mailto

o To

Digunakan untuk tujuan alamat E-mail penerima.
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o CC

Digunakan untuk menaruh suatu salinan pesan didalam

alamat  E-mail penerima.

o Subject

Dapat digunakan untuk menyediakan pokok pesan atau judul

dari pesan yang ditulis.

o Message Body

Digunakan untuk menulis pesan. Newline dapat digunakan

untuk memformat.

• Debugging Actions

Ø Comment

Digunakan untuk menambah komentar di kode anda. Komentar

tidak dilakukan ke semua program, hanya untuk membantu

dokumen apa yang sedang terjadi.

Ø Trace

Digunakan untuk menampilkan hasil dari suatu ungkapan di

dalam Debug Panel ketika movie sedang dimainkan.
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Gambar 150. Trace

c. Rangkuman 3

1) Dalam SWiSHmax terdapat fasilitas untuk menggambar grafik

berbentuk verktor. Fasilitas yang digunakan untuk menggambar

grafik tersebut terdapat pada toolbox. Gambar bisa diperbesar,

diperkecil, diputar semua dilakukan dengan pilihan pada toolbox.

Dengan menggunakan fasilitas pencil atau brezier dapat membuat

garis sendiri.

2) Efek pada SWiShmax digunakan untuk membuat animasi atau efek-

efek khusus pada obyek tertentu, seperti obyek yang berputar,

obyek yang perlahan-lahan menghilang atau berlahan-lahan

muncul, Obyek muncul dari samping kanan atau samping kiri atau

dari atas atau dari bawah. Selain untuk memberi animasi dan efek

pada obyek juga dapat digunakan untuk membuat animasi atau

memberi efek pada teks. Efek yang digunakan pada obyek dan

pada teks pada dasarnya bisa digunakan baik pada obyek maupun

teks, namun ada beberapa macam efk yang tidak dapat digunakan

untuk keduanya.

3) Event dan action merupakan dua hal yang tidak dapat dipisahkan.

Event adalah suatu keadaan, dimana jika keadaan itu dilakukan,

maka akan diklakukan suatu action atau lebih dari satu action.

d. Tugas 3

Lakukan pengamatan efek-efek apa saja yang dapat digunakan untuk

membuat animasi pada obyek  saja dan teks saja.
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e. Tes Formatif 3

Buat objek berikut kemudian tambahkan efek berdeyut pada objek

berikut, dengan menggunakan Appear Into Position.

f. Kunci Jawaban Formatif 3

Obyek dan animasinya  dibuat dengan cara sebagai berikut;

1) Pada Toolbox pilih AutoShape, pilih gambar hati, kemudian krusor

diletakkan pada bidang kerja SWiShmax.

2) Drag sehingga terbentuk gambar hati.

3) Klik kanan pada gambar hati tersebut,

4) Pilih effek untuk menambahkan effek berdenyut pada gambar hati.

5) Pilih Appear Into Position > Bullet-Fly By In, kemudian klik kiri

untuk memilihnya.

6) Untuk mencoba hasilnya, klik play.

Seperti pada gambar;
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g. Lembar Kerja 3

Tujuan

Peserta diklat mampu membuat berbagai macam bentuk teks dengan

menambah efek-efek yang ada pada fasilitas di SWiSHmax.

Alat dan Bahan
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     Seperangkat komputer dengan spesifikasi kebutuhan hardware

minimum sebagai berikut:

• Windows 95/98/ME/NT4/2000/Xp

• Pentium II

• 64 Mb RAM

• Monitor 800X600 pixel dengan 256 warna

Langkah Kerja

    Lakukan langkah-langkah sebagai berikut:

1) Klik Text pada toolbox, kemudian klik kiri pada bidang kerja

SWiSHmax untuk meletakkan teks.

2) Untuk menulis teks dengan mengetik disebelah kanan bidang kerja

SWiSHmax.

3) Untuk membuat teks menjadi arah horisontal dengan melakukan

pemilihan pada Text Flow, seperti gambar;

     Gambar Kerja
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4. Kegiatan Belajar 4 : Membuat Animasi 2D ke dalam multimedia

a. Tujuan Kegiatan Pembelajaran 4

1) Peserta diklat paham dan mampu menambahkan efek suara pada

animasi yang dibuat dengan menggunakan SWiSHmax.

2) Peserta diklat mampu melakukan link atau menghubungkan antara

frame atapun antar scane pada SWiSHmax.

3) Peserta diklat mampu membuat tombol yang beranimasi pada

SWiShmax.

b. Uraian Materi 4

1) Membuat animasi tombol

Animasi pada tombol digunakan untuk memperindah halaman web

yang akan dibuat. Dengan menggunakan efek-efek yang telah dibahas

dapat dikombinasi untuk membuat tombol yang menarik.

Berikut ini langkah-langkah untuk membuat animasi tombol, sebagai

berikut;

a) Buat Rounded Button warna merah dari Auto Shape pada Toolbar.

Gambar 151. Rounded Button

b) Buat teks “Next” pada bidang kerja menggunakan Text yang ada di

Toolbox.

Gambar 152. Teks “Next



135

c) Masukkan teks “Next” ke dalam Rounded Button, kemudian Drag

keduanya buat menjadi group untuk tombol, dengan cara Klik kanan

mouse pilih Gouping > Goup as Button.

Gambar 153. Grouping Tombol

d) Buka Outline Panel, sampai nampak seperti gambar.

Gambar 154. Jendela Outline Panel dan Button

e) Pilih pada Over State, tekan tombol Ctrl+C untuk meng-copy dan

Tekan Ctrl+V untuk paste untuk membuat duplikat di dalam Over

State.
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Gambar 155. Duplikat Shape

f) Klik kanan pada Rounded Button di Outline Panel, pilih Convert >

Convert to Sprite.

g) Klik ganda pada Sprite di Outline Panel, ini akan ditampilkan pada

Timeline untuk sprite objek.

                       (a) Di Timeline          (b) Setelah klik ganda pada Sprite

Gambar 156. Membuat Sprite

h) Di Timeline, Klik ganda pada frame 15 pada Rounded Button. Ini akan

memasukan sebuah efek ke tombol.
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Gambar 157. Membuat Efek

i) Klik ganda pada keyframe pada akhir efek yang tadi dibuat. Akan

muncul kotak dialog “Move Setting”. Dalam kotak dialog tersebut, pilih

Scale > Resixe to Scale > 300%. Kemudian pilih juga Alpha > To

Tranparant.

Gambar 158. Move Setting

j) Pada Timeline pilih Scane1, kemudian tekan Play. Lihat apakah dalam

membuat animasi tombol berhasil.

Gambar 159. Hasil Animasi Tombol saat  Play
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2) Membuat animasi loading

Animasi Loading biasanya digunakan untuk proses saat akan masuk ke

web, dibuat seindah mungkin untuk halaman web yang akan dibuat.

Berikut ini langkah-langkah untuk membuat animasi Loading, sebagai

berikut;

a) Buat Dengan Rectangle sebuah persegi dengan warna abu-abu.

Gambar 160. Membuat Persegi

b) Pastikan terpilih Scale pada tool Option.

c) Pilih Motion Part, letakkan krusor pada pegangan di tengah-tengah

persegi tarik kekanan tanpa melepas mouse kemudian lepaskan

ditempat yang diinginkan.

Gambar 161. Membuat Efek Gerak
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d) Kemudian pilih Select pada Toolbox.

e) Bagian belakang dari pegangan persegi tersebut, tekan tombol mouse

dan ditarik menuju ujung, kemudian lepaskan.

Gambar 162. Membuat Efek Loading

f) Setelah itu tekan tombol Play.

Gambar 163. Hasil Animasi Loading

3) Membuat repeat frame

Animasi ini digunakan untuk mengulang frame yang diinginkan.

Pengulangan dalam satu Scane hanya bisa untuk sekali perulangan

saja. Misal sudah membuat perulangan dari frame 20, maka tidak bisa

untuk membuat lagi perulangan dari 10 frame

Berikut ini langkah-langkah untuk membuat repeat frame, sebagai

berikut;
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a) Buatlah objek dengan Auto Shap bentuk Cube dengan warna merah di

bidang kerja SWiSHmax.

Gambar 164. Gambar objek Cube

b) Buatlah teks “SWiSHmax” dengan Text pada Options Toolbox.

Gunakan warna hijau jenis huruf Arial ukurannya menyesuaikan.

Letakkan di bidang objek Cube.

Gambar 165. Menulis”SWiSHmax”

c) Pilih pada objek, beri efek Fade In dari efek dasar.

Gambar 166. Memberi animasi Fade In
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d) Pilih Teks, beri pula efek Typewriter-Slow dari efek kompleks.

Gambar 167. Memberi animasi  Typewriter-Slow

e) Buat objek dari frame 1 sampai frame 22.

f) Sedang untuk teks buat dari frame 24 sampai frame 59.

g) Letakkan krusor pada scane frame 59, kemudian klik kanan.

h) Pilih Movie Control > gotoAndPlay> gotoAndPlay(Frame).

Gambar 168. Memberi animasi  Repeat Frames

i) Setelah itu akan nampak huruf ‘s’ dengan anak panah diatasnya. Set

Frame pada namor frame 25.
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(a) Pada Timeline

(b) Mengeset Frame

Gambar 169. Memberi animasi  Repeat Frames

j) Kemudian mainkan movie dengan menekan Play.

Gambar 170. Hasil animasi perulangan Frame

4) Membuat efek suara

Efek suara digunakan untuk memberi suara pada saat tertentu di

frame pada Timeline. Dalam satu scane bisa terdapat lebih dari satu

suara yang di masukkan.

Berikut ini langkah-langkah untuk membuat efek suara, sebagai

berikut;

a) Buat objek berbentuk lingkaran.
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Gambar 171. Menggambar lingkaran

b) Import file suara, dari menu File > Import...

Gambar 172. Jendela Import

c) Pilih file suara yang diinginkan, lalu tekan Open.

d) Masuk Scrip, kemudian tekan Add Scrip Sound > PlaySound(...).

Gambar 173. Jendela Script
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e) Klik kiri pada file suara yang sudah di import.

f) Masuk ke Scane lagi, kemudian play.

5) Membuat link antar scane

Link antara scane dilakukan terutama di halaman web, Sangat

memungkinkan untuk menghubungkan antara halaman-halaman dari

web. Sehingga dengan menekan tombol (Next; misalnya) maka

halaman akan berganti dengan halaman yang lain.

Berikut ini langkah-langkah untuk membuat link atau hubungan antar

scane, sebagai berikut;

a) Buat persegi panjang dengan Rectangle.

Gambar 174. Menggambar persegi panjang

b) Buat Gambar bintang dengan memanfaatkan Auto Shap.

Gambar 175. Menggambar Bintang

c) Buat scane baru lagi, dengan klik kanan pada Outline Panel >

Insert Scane.
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Gambar 176. Menambah Scane

d) Buat persegi panjang pada scane2.

Gambar 177. Menggambar Segi Panjang

e) Tambahkan efek pada persegi panjang di scane2, dengan

menggunakan Motion Part.

Gambar 178. Efek Motion Part

f) Pilih scane1, untuk menambahkan efek pada persegi panjang dengn

Fade In.

g) Bintang pada Scane1 dibuat animasi memutar dengan menggunakan

Transform.
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Gambar 179. Efek Fade In dan Transform

h) Baik pada scane1 maupun pada scane2 diakhir framenya stop movie

dengan klik kanan pada Timeline Ruler > Movie Control > Stop().

i) Pilih objek bintang kemudian masuk ke Script > Add Script > Movie

Control > gotoAndPlay> NextScaneAndPlay(). Pada target dipilih

Scane2.

j) Kemudian masuk ke Scane lagi dan play movie. Saat play persegi

perlahan-lahan akan nampak dan kemudian bintang akan berputar dan

kemudian diam. Lalu klik kiri pada objek bintang untuk ganti halaman

ke scane2.

                                (a) Scane1                         (b) Scane2
     Gambar 180. hasil saat play movie

c. Rangkuman 4

1) Tambahan efek suara dapat digunakan untuk menambahkan pada

tombol, sehingga sewaktu tombol disentuh krusor berbunyi.

Disamping itu dapat digunakan sepanjang movie. Efek suara ini

dapat dihentikan sesuai dengan keperluan.

2) Perulangan dapat dilakukan antar frame. Perulangan antar frame

akan nampak bahwa animasi yang dibuat akan berulang-ulang

terus. Perulangan ini dapat dimulai tergantung dari kita mau
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memasukkan nomor frame berapa yang akan kita ulang sampai

akhir.

3) Link atau hubungan antar scane dalam penerapannya dapat

digunakan pada halaman web. Setiap scane berarti setiap movie

yang dibuat. Selain untuk halaman web ini juga dapat digunakan

untuk presentasi. Baik obyek maupun teks dapat digunakan untuk

meng-link ke halaman selanjutnya maupun halaman sebelumnya.

d. Tugas 4

Amati perbedaan atau perubahan yang terjadi saat teks dan obyek

yang telah digunakan untuk media meng-link atau menghubungkan

antar scane. Apa perbedaan dari keduanya.

e. Tes Formatif 4

     Buatlah teks yang mengitari lingkaran dengan sudut 45 derajat,

sehingga nampak seperti animasi 3    Dimensi. Acuan seperti pada

gambar berikut;

f. Kunci Jawaban Formatif 4

Dibuat dengan cara sebagai berikut;

1) Membuat lingkaran dengan menggunakan fasilitas Ellpis.

2) Atur pada Fill dengan Radial Gradient warna biru seperti gambar.

3) Kemudian buat tulisan “keliling” dengan menggunakan fasilitas

Text.



148

4) Pada tulisan tersebut tambahkan efek Snake dengan mengatur

agar posisinya 45 derajat. Seperti gambar;

g. Lembar Kerja 4

    Tujuan

Peserta diklat mampu membuat halaman web sendiri dengan

memanfaatkan fasilitas yang sudah ada pada SWiSHmax.

    Alat dan Bahan

     Seperangkat komputer dengan spesifikasi kebutuhan hardware

minimum sebagai berikut;

• Windows 95/98/ME/NT4/2000/Xp

• Pentium II

• 64 Mb RAM

• Monitor 800X600 pixel dengan 256 warna
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    Langkah Kerja

    Lakukan langkah-langkah berikutn ini;

1) Pada halaman pertama (Scane1)

a)  Membuat tombol

(1) Buatlah lingkaran menggunakan Ellips dari Toolbox, pada Fill

set pada Radial Gradient.

(2) Buatlah segitiga menggunakan Auto Shape dengan memilih

Poligon Segi lima, kemudian klik kanan untuk membuat

menjadi segi tiga, set pada fill pada Radial gradient.

(3) Copy paste menjadi dua dengan klik kanan pada objek >

Copy Objek, kemudian klik kanan lagi ditempat yang lain

dan paste objek buat warna sesuai dengan gambar.

(4) Buatlah ketiga objek tersebut menjadi objek tombol, dengan

men-drag ketiga objek kemudian klik kanan > Group Button.

(5) Pada Outline Panel, nampak seperti gambar.
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(6) Pada segitiga warna kuning tambakkan effect Slide Out to

top dan juga tambahkan tulisan NEXT.

(7) Pada segitiga warna biru dan juga pada lingkaran dengan

effect Move.

(8) Kemudian untuk menambahkan fasilitas Link, ke scane

selanjutnya:

<> Klik pada tombol pada OutLine Panel, kemudian klik

kanan > Script> Movie Control > GotoAndPlay>

NextscaneGotoAndPlay, terlihat pada gambar.
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<> Kemudian akan tampil jendela Script untuk

NextscaneGotoAndPlay, terlihat pada gambar. Tombol sudah

linK atau terhubung dengan scane selanjutnya sewaktu di

klik.

b)  Membuat tulisan

o Pilih Text pada Toolbox, kemudian klik kiri pada jendela

kerja SWISHmax untuk memulai menulis, Ketik tulisan

‘WELCOME TO MY WEBSITE’ dan  ‘TERIMA KASIH ATAS

KUNJUNGN ANDA’.

o Pada ‘WELCOME TO MY WEBSITE’ ditambahkan dengan

menggunakan efek Typewriter-slow.

o Pada ‘TERIMA KASIH ATAS KUNJUNGAN ANDA’ ditambahkan

dengan efek Fade In.



152

c)  Membuat background

o Pilih Rectangle pada Toolbox kemudian buat segiempat pada

bidang kerja SWiSHmax.

o Set pada Fill pada Linear Gradient, nampak seperti gambar.

d)  Membuat garis-garis

o Pada garis lurus, pilih Line untuk mengambar. Untuk

mempermudah agar garis lurus sewaktu membaut garis

dengan menekan tombol Shift. Kemudian garis kedua
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dibuat dengan copy paste dari objek pertama. Ini berlaku

untuk garis harisontal maupun mendatar.

o Pada dua garis yang lain dibuat dengan menggunakan

pilihan Bezier pada Toolbox. Untuk membuat lekukan

dengan melakukan klik kiri sekali saja sedang untuk

mengakhiri double klik kiri.

o Nampak pada gambar.

e)  Membuat 3 bintang

o Buatlah bintang tersebut dengan menggunakan Auto Shape

pada Toolbox.

o Copy paste untuk membuat dua bintang yang lain, dengan

Ctrl+C untuk meng-copy kemudian Ctrl+P untuk mem-

paste.

o Tambahkan efek Sinema-Star War pada masing-masing dari

bintang tersebut.

o Atur posisi efek yang tidak sama untuk membuat pergerakan

semakin bagus.

o Setelah itu tambahkan efek Move lagi pada ketiga bintang

tersebut, terlihat pada Time Line Panel.
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f)  Membuat lingkaran

o Membuat lingkaran dengan pilihan Ellips pada Toolbox.

o Untuk seting pada Fill dibuat Radial Gradient, dengan

mengaktifkan garis tepi.

o Kemudian tambahkan efek Wave Stretch Tall dan Skinny

pada lingkaran, nampak pada gambar.
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2) Pada halaman Kedua (Scane2)

a) Membuat Ellips.

(1) Pilih Ellips pada Toolbox, kemudian gambarkan pada bidang

kerja SWiSHmax.

(2) Berikan garis tepi pada objek Ellips, terlihat seperti gambar.

b) Membuat Tulisan

o Pilih Text pada Toolbox, kemudian klik kiri pada jendela

kerja SWISHmax untuk memulai menulis, Ketik tulisan

‘Under Contruction’.

o Tambahkan efek Fade In pada Tulisan tersebut, terlihat pada

gambar.
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Gambar Kerja

Posisi pada Time Line Panel keseluruhan.

Tampilan pada Bidang kerja SWiSHmax.

Scane Pertama

Scane Kedua
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BAB III

EVALUASI

A. PERTANYAAN

1. Jelaskan secara singkat apa yang peserta diklat ketahui tentang

software Animasi 2 Dimensi SWISHmax.

2. Sebutkan jenis format file yang dapat diubah oleh software SWISHmax

? dan uraikan prosedur mengubahnya ?

3. Uraikan langkah penyimpanan file pada harddisk ?

4. Software Animasi 2 Dimensi SWISHmax menyediakan fungsi event.

Apa yang Sdr ketahui tetang event dan ada berapa tipe event,

jelaskan ?

5. Animasi dapat digunakan untuk mengulang frame yang diinginkan.

Buatlah animasi dengan fungsi repeat frame !

6. Obyek yang telah dirancang melalui SWISHmax dapat dihubungkan

dengan halaman Web. Praktikkan fungsi yang dapat menghubungkan

tersebut!

B. KUNCI JAWABAN EVALUASI

1. Program SWiSHmax adalah program yang digunakan untuk membuat

animasi Flash tanpa menggunakan program Flash. Berbagai animasi

seperti teks, image atau grafik dapat dibuat dengan mudah. Program

ini dapat digunakan untuk mengimport dan mengekport file sehingga

lebih memudahkan dalam pembuatan animasi. Animasi SWISHmax

didukung oleh berbagai halaman web, program macromedia Flash.
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2. Jenis format file yang dapat diubah oleh software SWISHmax  adalah

format: (a) SWf, (b) SWF + Html, (c) Avi, dan (d) Clipboard. Sedang

prosedur yang dilakukan sebagai berikut:

a. Masuk pada menu bar File > Export,

b.  pilih format yang diinginkan kemudian klik kiri mouse.

c. Setelah itu akan tampil jendela penyimpanan, beri nama file

tersebut setelah itu klik save.

3. Menyimpan file dalam SWiSHmax sebagai berikut;

a. Masuk pada menu bar File > Save as atau save,

Baik Save as atau Save hampir sama, bedanya kalau

menggunakan Save as maka penyimpanan file baru, sedang kalau

menggunakan Save file sudah tidak baru lagi atau file sudah

pernah di simpan.

b. Atau dengan menggunakan kombinasi tombol Ctrl + S pada

keyboard.

 4. Event adalah suatu keadaan, dimana jika keadaan itu dilakukan, maka

akan diklakukan suatu action atau lebih dari satu action. Terdapat tiga

tipe Event, yakni:

a. Frame,  terjadi saat movie berjalan dari frame ke frame secara

spesifik.

b. button atau tombol akan terjadi saat terjadi interaksi antara mouse

dengan objek. Menambah event tombol di objek untuk membuat

agar seolah-olah seperti tombol dan mau mengikuti respon dari

pergerakan mouse.
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c. Event self pada button atau tombol akan terjadi saat terjadi

interaksi antara mouse dengan objek saat ditekan. Disini lebih dari

action yang dapat ditampilkan.

5. Perulangan dapat dilakukan antar frame. Perulangan antar frame akan

nampak bahwa animasi yang dibuat akan berulang-ulang terus.

Perulangan ini dapat dimulai tergantung dari kita mau memasukkan

nomor frame berapa yang akan kita ulang sampai akhir.

6. Link atau hubungan antar scane dalam penerapannya dapat digunakan

pada halaman web. Setiap scane berarti setiap movie yang dibuat.

Selain untuk halaman web ini juga dapat digunakan untuk presentasi.

Baik obyek maupun teks dapat digunakan untuk meng-link ke halaman

selanjutnya maupun halaman sebelumnya.

C. Kriteria Kelulusan

Aspek
Skor

(1-10)
Bobot Nilai Keterangan

Kognitif (soal no 1 s/d 4) 3

Ketrampilan mengoperasikan
software SWISHmax (soal 5 & 6)

5

Kecepatan waktu 2

Nilai Akhir

Syarat lulus nilai
minimal 70 dan
skor setiap aspek
minimal 7

Kategori kelulusan:

70 – 79 : Memenuhi kriteria mininal. Dapat bekerja dengan bimbingan.

80 – 89 : Memenuhi kriteria minimal. Dapat bekerja tanpa bimbingan.

90 – 100 : Di atas kriteria minimal. Dapat bekerja tanpa bimbingan.
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BAB IV

PENUTUP

Setelah peserta diklat belajar dan praktikum “Mengoperasikan Software

2D Animation SWISHmax”, mengerjakan semua tugas tepat waktu serta

menyelesaikan evaluasi akhir maka berdasarkan kriteria penilaian, peserta

diklat dapat dinyatakan lulus/ tidak lulus. Apabila dinyatakan lulus maka

dapat melanjutkan ke modul berikutnya sesuai dengan alur peta kududukan

modul, sedangkan apabila dinyatakan tidak lulus maka peserta diklat harus

mengulang modul ini dan tidak diperkenankan mengambil modul selanjutnya.
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